HP LaserJet Pro 200 color M251 Series Printer

User Guide
# Table of contents

1 **Product introduction** ............................................................................................................. 1
   Product views ......................................................................................................................... 2
      Product front view .............................................................................................................. 2
      Product back view ............................................................................................................ 3
   Serial number and model number location ....................................................................... 3
   Control panel layout ........................................................................................................... 4
      LCD control panel ............................................................................................................ 4
      Touchscreen control panel .............................................................................................. 5
   Touchscreen Home screen ................................................................................................. 7
   Print product reports ............................................................................................................ 8
      Print product reports (LCD control panel) ........................................................................ 9
      Print product reports (touchscreen control panel) ........................................................... 9
   Printer sharing disclaimer ................................................................................................. 10

2 **Paper tray** .......................................................................................................................... 11
   Supported paper sizes ......................................................................................................... 12
   Supported paper types ....................................................................................................... 14
   Load the paper input tray .................................................................................................. 15

3 **Print** ..................................................................................................................................... 17
   Supported printer drivers (Windows) .................................................................................... 18
   Change print-job settings (Windows) .................................................................................. 19
      Priority for changing print-job settings ........................................................................ 19
      Change the settings for all print jobs until the software program is closed ............... 19
      Change the default settings for all print jobs ............................................................... 19
      Change the product configuration settings ................................................................. 20
   Change print-job settings (Mac OS X) ............................................................................... 21
      Priority for changing print-job settings ........................................................................ 21
      Change the settings for all print jobs until the software program is closed ............... 21
      Change the default settings for all print jobs ............................................................... 21
      Change the product configuration settings ................................................................. 21
4 Manage and maintain the product ........................................................................... 55
   Use the HP Reconfiguration Utility to change the product connection ................. 56
   Use HP Web Services applications ........................................................................... 57
      Use HP Web Services applications (LCD control panel) ........................................ 57
      Use HP Web Services applications (touchscreen control panel) .......................... 57
   Configure IP network settings .................................................................................. 58
      View or change network settings ........................................................................... 58
      Manually configure IPv4 TCP/IP parameters from the control panel .................. 58
         Manually configure IPv4 TCP/IP parameters (LCD control panel) ...................... 58
         Manually configure IPv4 TCP/IP parameters (touchscreen control panel) ...... 58
      Rename the product on a network ....................................................................... 59
      Link speed and duplex settings .......................................................................... 60
         Link speed and duplex settings (LCD control panel) ........................................... 60
         Link speed and duplex settings (touchscreen control panel) ............................ 60
   HP Device Toolbox (Windows) .................................................................................. 62
   HP Utility for Mac OS X ........................................................................................... 64
      Open the HP Utility ................................................................................................. 64
      HP Utility features .................................................................................................. 64
   HP Web Jetadmin ....................................................................................................... 65
   Product security features ......................................................................................... 66
      Set or change the product password ..................................................................... 66
   Economy settings ..................................................................................................... 67
      Print with EconoMode ............................................................................................. 67
      Set the sleep delay ................................................................................................ 67
         Set the sleep delay (LCD control panel) .............................................................. 67
         Set the sleep delay (touchscreen control panel) ................................................ 68
      Set the Auto Power Down delay .......................................................................... 68
         Set the Auto Power Down delay (LCD control panel) ......................................... 68
         Set the Auto Power Down delay (touchscreen control panel) .......................... 69
   Print when a toner cartridge is at estimated end of life ............................................ 70
      Enable or disable the At Very Low settings (LCD control panel) ......................... 70
      Enable or disable the At Very Low settings (touchscreen control panel) .......... 71
   Store and recycle supplies ....................................................................................... 72
      Recycle supplies .................................................................................................... 72
      Toner cartridge storage ......................................................................................... 72
Replacement instructions ......................................................................................................... 73
Replace the toner cartridges .................................................................................................. 73

Update the firmware ............................................................................................................... 77
Manually update the firmware (LCD control panel) ............................................................ 77
Manually update the firmware (touchscreen control panel) .............................................. 77
Set the product to automatically update the firmware (LCD control panel) ..................... 77
Set the product to automatically update the firmware (touchscreen control panel) ........... 78

5 Solve problems ............................................................................................................... 79
Solve problems checklist ...................................................................................................... 80
  Step 1: Make sure that the product is set up correctly .................................................. 80
  Step 2: Check the cabling or wireless connection ........................................................ 80
  Step 3: Check the control panel for error messages ..................................................... 81
  Step 4: Check the paper .......................................................................................... 81
  Step 5: Check the software ....................................................................................... 81
  Step 6: Test print functionality ................................................................................... 81
  Step 7: Check the supplies ....................................................................................... 81
  Step 8: Try sending a print job from a computer ......................................................... 81

Restore the factory-set defaults .............................................................................................. 82
Restore the factory-set defaults (LCD control panel) ........................................................ 82
Restore the factory-set defaults (touchscreen control panel) ............................................ 82

Control panel help system ..................................................................................................... 83
Interpret control panel messages .............................................................................................. 84
Control panel message types ............................................................................................ 84
Control panel messages ....................................................................................................... 84
  10.X00Y Supply Error ................................................................................................. 84
  49 Error Turn off then on ........................................................................................... 84
  50.x Fuser Error Turn off then on .............................................................................. 85
  51.XX Error Turn off then on .................................................................................... 85
  54.XX Error Turn off then on .................................................................................... 85
  55.X Error Turn off then on ....................................................................................... 86
  57 Fan error Turn off then on ..................................................................................... 86
  59.X Error Turn off then on ....................................................................................... 86
  79 Error Turn off then on ........................................................................................... 86
  Black Cartridge Low .......................................................... Black in wrong position .......... 87
  Black Very Low .......................................................... Black in wrong position .......... 87
  Cleaning ...................................................................................................................... 88
  Cyan Cartridge Low .......................................................... Cyan in wrong position .......... 88
  Cyan Very Low .......................................................... Cyan in wrong position .......... 88
Device error Press [OK] ................................................................. 89
Door open .................................................................................. 89
Genuine HP supply installed ...................................................... 89
Incompatible <color> ................................................................. 89
Incorrect supplies .................................................................... 89
Install <color> cartridge ............................................................ 90
Invalid driver Press [OK] ............................................................ 90
Jam in <location> ..................................................................... 90
Jam in Tray 1 Clear jam and then Press [OK] ......................... 90
Load tray 1 Press [OK] for available media .......................... 90
Load tray 1 <TYPE>, <SIZE> ..................................................... 91
Load tray 1 PLAIN <SIZE> Cleaning Mode ............................ 91
Magenta Cartridge Low ............................................................ 91
Magenta in wrong position ..................................................... 91
Magenta Very Low ................................................................. 91
Manual duplex Load tray 1 Press [OK] ................................ 92
Memory is low Press [OK] ....................................................... 92
Misprint Press [OK] ................................................................ 92
Print failure, press OK. If error repeats, turn off then on. .... 92
Rear door open ....................................................................... 93
Remove shipping lock from <color> cartridge .................... 93
Remove shipping locks from cartridges .............................. 93
Replace <color> ...................................................................... 93
Supplies low .......................................................................... 94
Unexpected size in tray 1 Load <size> Press [OK] ............. 94
Unsupported <color> Press [OK] to continue ....................... 94
Used <color> cartridge is installed Press [OK] to continue ...... 94
Used <color> in use ................................................................ 94
Used supplies in use ............................................................ 95
Yellow Cartridge Low ............................................................ 95
Yellow in wrong position ...................................................... 95
Yellow Very Low ................................................................. 95

Paper feeds incorrectly or becomes jammed .......................... 96
  The product does not pick up paper .................................. 96
  The product picks up multiple sheets of paper ................. 96
  Prevent paper jams ........................................................... 96

Clear jams .............................................................................. 97
  Jam locations ..................................................................... 97
  Clear jams in the paper input tray .................................. 97
  Clear jams from the output bin ....................................... 99
  Clear jams from the rear door ....................................... 99
Wireless connectivity checklist .......................................................................................... 117
The product does not print after the wireless configuration completes ........................... 117
The product does not print, and the computer has a third-party firewall installed ........... 118
The wireless connection does not work after moving the wireless router or product ...... 118
Cannot connect more computers to the wireless product ............................................... 118
The wireless product loses communication when connected to a VPN ......................... 118
The network does not appear in the wireless networks list .............................................. 118
The wireless network is not functioning ........................................................................ 119
Perform a wireless network diagnostic test .................................................................... 119
Reduce interference on a wireless network .................................................................... 120
Solve product software problems with Windows .............................................................. 121
A printer driver for the product is not visible in the Printer folder ................................. 121
An error message was displayed during the software installation ................................. 121
The product is in Ready mode, but nothing prints ......................................................... 121
Solve product software problems with Mac OS X .......................................................... 123
The printer driver is not listed in the Print & Fax list ...................................................... 123
The product name does not appear in the product list in the Print & Fax list .................. 123
The printer driver does not automatically set up the selected product in the Print & Fax list .................................................................................................................. 123
A print job was not sent to the product that you wanted ................................................ 124
When connected with a USB cable, the product does not appear in the Print & Fax list after the driver is selected. ................................................................. 124
You are using a generic printer driver when using a USB connection ............................ 124
Remove software (Windows) ........................................................................................... 125
Remove software (Mac OS X) ........................................................................................ 126

6 Supplies and accessories ................................................................................................. 127
Order parts, accessories, and supplies .............................................................................. 128
HP policy on non-HP supplies ....................................................................................... 128
HP anticounterfeit Web site ............................................................................................ 128

Index .................................................................................................................................. 129
1 Product introduction

- Product views
- Print product reports
- Printer sharing disclaimer
Product views

Product front view

1. Output bin
2. Walk-up USB port (HP LaserJet Pro 200 color M251nw Printer only)
3. Power button
4. Input tray
5. Jam access door
6. LCD control panel (HP LaserJet Pro 200 color M251n Printer) or color touchscreen control panel (HP LaserJet Pro 200 color M251nw Printer)
7. Front door latch
Product back view

1 Rear door
2 Power connection
3 Hi-Speed USB 2.0 port
4 Network port

Serial number and model number location

The serial number and product model number label is on the back of the product.
## Control panel layout

### LCD control panel

**NOTE:** This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Control-panel display: The display provides information about the product. Use the menus on the display to establish product settings.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Back arrow button: Use this button for the following actions:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Exit the control-panel menus.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Scroll back to a previous menu in a submenu list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Scroll back to a previous menu item in a submenu list (without saving changes to the menu item).</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Cancel button: Press this button to cancel a print job whenever the attention light is blinking or to exit the control-panel menus.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Left arrow button: Use this button to navigate through the menus or to decrease a value that appears on the display.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>OK button: Press the OK button for the following actions:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Open the control-panel menus.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Open a submenu displayed on the control-panel display.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Select a menu item.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Clear some errors.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Begin a print job in response to a control-panel prompt (for example, when the message <strong>Press [OK] to continue</strong> appears on the control-panel display).</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Right arrow button: Use this button to navigate through the menus or to increase a value that appears on the display.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Web Services button: This button provides quick access to HP Web Services features, including HP ePrint.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Ready light (green): The Ready light is on when the product is ready to print. It blinks when the product is receiving print data, or when the product is in sleep mode.</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Attention light (amber): The Attention light blinks when the product requires user attention.</td>
<td></td>
</tr>
</tbody>
</table>

**Touchscreen control panel**

*NOTE:* This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

![Touchscreen control panel diagram]

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Wireless light: indicates the wireless network is enabled. The light blinks while the product is establishing a connection to the wireless network.</td>
</tr>
<tr>
<td>2</td>
<td>Touchscreen display</td>
</tr>
<tr>
<td>3</td>
<td>Attention light: indicates a problem with the product</td>
</tr>
<tr>
<td>4</td>
<td>Ready light: indicates the product is ready</td>
</tr>
<tr>
<td>5</td>
<td>Help button and light: provides access to the control panel help system</td>
</tr>
<tr>
<td>6</td>
<td>Right arrow button and light: moves the cursor to the right or moves the display image to the next screen</td>
</tr>
</tbody>
</table>

*NOTE:* This button illuminates only when the current screen can use this feature.

| 7 | Cancel button and light: clears settings, cancels the current job or exits the current screen |

*NOTE:* This button illuminates only when the current screen can use this feature.

| 8 | Back button and light: returns to the previous screen                        |

*NOTE:* This button illuminates only when the current screen can use this feature.
| 9 | Left arrow button and light: moves the cursor to the left  
**NOTE:** This button illuminates only when the current screen can use this feature. |
| 10 | Home button and light: provides access to the Home screen |
Touchscreen Home screen

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

The Home screen provides access to the product features, and it indicates the product status.

NOTE: Depending on the product configuration, the features on the Home screen can vary. The layout might also be reversed for some languages.

1 Web Services button: provides quick access to HP Web Services features, including HP ePrint

HP ePrint is a tool that prints documents by using any email enabled device to send them to the product’s email address.

2 Setup button: provides access to the main menus

3 Wireless button: provides access to the Wireless menu and wireless status information

NOTE: When you are connected to a wireless network, this icon changes to a set of signal strength bars.

4 Network button: provides access to network settings and information. From the network settings screen, you can print the Network Summary page.

5 Information button: provides product status information. From the status summary screen, you can print the Config Report page.

6 Supplies button: provides information about supplies status. From the supplies summary screen, you can print the Supplies Status page.

7 Apps button: provides access to the Apps menu to print directly from Web applications that you have downloaded from the HP ePrintCenter Web site at www.hpeprintcenter.com

8 Product status

9 USB button: provides access to the USB Flash Drive menu
Print product reports

Product reports reside within the product memory. These pages help diagnose and solve problems with the product.

**NOTE:** If the product language was not correctly set during installation, you can set the language manually so the information pages print in one of the supported languages. Change the language by using the **System Setup** menu on the control panel or the embedded Web server.

From the **Reports** menu, you can print several informative pages about the product.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demo Page</td>
<td>Prints a page that demonstrates print quality</td>
</tr>
<tr>
<td>Menu Structure</td>
<td>Prints a map of the control panel-menu layout. The active settings for each menu are listed.</td>
</tr>
<tr>
<td>Config Report</td>
<td>Prints a list of all the product settings. Includes network information when the product is connected to a network.</td>
</tr>
<tr>
<td>Supplies Status</td>
<td>Prints the status for each toner cartridge, including the following information:</td>
</tr>
<tr>
<td></td>
<td>- Estimated percentage of cartridge life remaining</td>
</tr>
<tr>
<td></td>
<td>- Approximate pages remaining</td>
</tr>
<tr>
<td></td>
<td>- Part numbers for HP toner cartridges</td>
</tr>
<tr>
<td></td>
<td>- Number of pages printed</td>
</tr>
<tr>
<td>Network Summary</td>
<td>Prints a list of all product network settings</td>
</tr>
<tr>
<td>Usage Page</td>
<td>Prints a page that lists PCL pages, PCL 6 pages, PS pages, pages that were jammed or mispicked in the product, monochrome (black and white) or color pages; and reports the page count</td>
</tr>
<tr>
<td>PCL Font List</td>
<td>Prints a list of all the PCL fonts that are installed</td>
</tr>
<tr>
<td>PS Font List</td>
<td>Prints a list of all the PostScript (PS) fonts that are installed</td>
</tr>
<tr>
<td>PCL6 Font List</td>
<td>Prints a list of all the PCL6 fonts that are installed</td>
</tr>
<tr>
<td>Color Usage Log</td>
<td>Prints a report that shows the user name, application name, and color usage information on a job-by-job basis</td>
</tr>
<tr>
<td>Service Page</td>
<td>Prints the service report</td>
</tr>
<tr>
<td>Diagnostics Page</td>
<td>Prints the calibration and color diagnostics pages</td>
</tr>
<tr>
<td>Print Quality Page</td>
<td>Prints a page that helps solve problems with print quality</td>
</tr>
</tbody>
</table>
Print product reports (LCD control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. At the control panel, press the OK button to open the menus.
2. Open the Reports menu.
3. Select the report you want to print, and then press the OK button to print the report.

Print product reports (touchscreen control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Reports button.
3. Touch the name of the report that you want to print.
Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.
2 Paper tray

- Supported paper sizes
- Supported paper types
- Load the paper input tray
Supported paper sizes

This product supports a number of paper sizes, and it adapts to various paper.

**NOTE:** To obtain best print results, select the appropriate paper size and type in your print driver before printing.

<table>
<thead>
<tr>
<th>Table 2-1 Supported paper and print media sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
</tr>
<tr>
<td>Letter</td>
</tr>
<tr>
<td>Legal</td>
</tr>
<tr>
<td>Executive</td>
</tr>
<tr>
<td>8.5 x 13</td>
</tr>
<tr>
<td>4 x 6</td>
</tr>
<tr>
<td>5 x 8</td>
</tr>
<tr>
<td>A4</td>
</tr>
<tr>
<td>A5</td>
</tr>
<tr>
<td>A6</td>
</tr>
<tr>
<td>B5 (JIS)</td>
</tr>
<tr>
<td>10 x 15 cm</td>
</tr>
<tr>
<td>16k</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Custom</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 2-2 Supported envelopes and postcards</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
</tr>
<tr>
<td>Japanese Postcard</td>
</tr>
<tr>
<td>Postcard (JIS)</td>
</tr>
<tr>
<td>Double Japan Postcard Rotated</td>
</tr>
<tr>
<td>Double Postcard (JIS)</td>
</tr>
<tr>
<td>Envelope #10</td>
</tr>
<tr>
<td>Envelope DL</td>
</tr>
<tr>
<td>Envelope C5</td>
</tr>
<tr>
<td>Size</td>
</tr>
<tr>
<td>-----------------</td>
</tr>
<tr>
<td>Envelope B5</td>
</tr>
<tr>
<td>Envelope Monarch</td>
</tr>
</tbody>
</table>
## Supported paper types

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Dimensions&lt;sup&gt;1&lt;/sup&gt;</th>
<th>Weight</th>
<th>Capacity&lt;sup&gt;2&lt;/sup&gt;</th>
<th>Paper orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper, including the following types:</td>
<td>Minimum: 76 x 127 mm (3 x 5 in)</td>
<td>60 to 90 g/m² (16 to 24 lb)</td>
<td>Up to 150 sheets of 75 g/m² (20 lb bond)</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Plain</td>
<td>Maximum: 216 x 356 mm (8.5 x 14 in)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Letterhead</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preprinted</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prepunched</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thick paper</td>
<td>Same as for paper</td>
<td>Up to 200 g/m² (53 lb)</td>
<td>Up to 15 mm (.59 in) stack height</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Cover paper</td>
<td>Same as for paper</td>
<td>Up to 200 g/m² (53 lb)</td>
<td>Up to 15 mm (.59 in) stack height</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Glossy paper</td>
<td>Same as for paper</td>
<td>Up to 220 g/m² (59 lb)</td>
<td>Up to 15 mm (.59 in) stack height</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Photo paper</td>
<td>Same as for paper</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transparencies</td>
<td>A4 or Letter</td>
<td>Thickness: 0.12 to 0.13 mm (4.7 to 5.1 mils)</td>
<td>Up to 50 sheets</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Labels&lt;sup&gt;3&lt;/sup&gt;</td>
<td>A4 or Letter</td>
<td>Thickness: up to 0.23 mm (9 mils)</td>
<td>Up to 50 sheets</td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
<tr>
<td>Envelopes</td>
<td>COM 10</td>
<td>Up to 90 g/m² (24 lb)</td>
<td>Up to 10 envelopes</td>
<td>Side to be printed on face-up, with the stamp-end at the back of the tray</td>
</tr>
<tr>
<td></td>
<td>Monarch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>C5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>B5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Postcards or index cards</td>
<td>100 x 148 mm (3.9 x 5.8 in)</td>
<td>Up to 50 sheets</td>
<td></td>
<td>Side to be printed on face-up, with the top edge at the back of the tray</td>
</tr>
</tbody>
</table>

<sup>1</sup> The product supports a wide range of standard and custom sizes of paper. Check the printer driver for supported sizes.

<sup>2</sup> Capacity can vary depending on paper weight and thickness, and environmental conditions.

<sup>3</sup> Smoothness: 100 to 250 (Sheffield)
Load the paper input tray

1. Pull the tray out of the product.

2. Slide open the paper length and width guides.

3. To load Legal-size paper, extend the tray by pressing and holding the extension tab while pulling the front of the tray outward.

   **NOTE:** When loaded with Legal-size paper, the tray extends from the front of the product approximately 51 mm (2 inches).
4. Place the paper in the tray and make sure that it is flat at all four corners. Slide the paper length and width guides so that they are against the stack of paper.

   **NOTE:** The tray capacity is 150 sheets.

5. Push down on the paper to make sure that the paper stack is below the paper limit tabs on the side of the tray.

6. Slide the tray into the product.
3 Print

- Supported printer drivers (Windows)
- Change print-job settings (Windows)
- Change print-job settings (Mac OS X)
- Print tasks for Windows
- Print tasks for Mac OS X
- Additional print tasks (Windows)
- Additional print tasks (Mac OS X)
- Create archival-quality prints
- Color printing
- Use HP ePrint
- Use AirPrint
- Walk-up USB printing
Supported printer drivers (Windows)

Printer drivers provide access to the product features and allow the computer to communicate with the product (using a printer language). Check the installation notes and readme files on the product CD for additional software and languages.

HP PCL 6 driver description

- Installs from the Add Printer wizard
- Provided as the default driver
- Recommended for printing in all supported Windows environments
- Provides the overall best speed, print quality, and product-feature support for most users
- Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows environments
- Might not be fully compatible with third-party and custom software programs that are based on PCL 5

HP UPD PS driver description

- Available for download from the Web at www.hp.com/support/ljcolorm251series
- Recommended for printing with Adobe® software programs or with other highly graphics-intensive software programs
- Provides support for printing from postscript emulation needs, or for postscript flash font support

HP UPD PCL 5 driver description

- Available for download from the Web at www.hp.com/support/ljcolorm251series
- Compatible with previous PCL versions and older HP LaserJet products
- The best choice for printing from third-party or custom software programs
- Designed for use in corporate Windows environments to provide a single driver for use with multiple printer models
- Preferred when printing to multiple printer models from a mobile Windows computer
Change print-job settings (Windows)

Priority for changing print-job settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

- **Page Setup dialog box**: Click **Page Setup** or a similar command on the **File** menu of the program you are working in to open this dialog box. Settings changed here override settings changed anywhere else.

- **Print dialog box**: Click **Print**, **Print Setup**, or a similar command on the **File** menu of the program you are working in to open this dialog box. Settings changed in the **Print** dialog box have a lower priority and usually do not override changes made in the **Page Setup** dialog box.

- **Printer Properties dialog box (printer driver)**: Click **Properties** in the **Print** dialog box to open the printer driver. Settings changed in the **Printer Properties** dialog box usually do not override settings anywhere else in the printing software. You can change most of the print settings here.

- **Default printer driver settings**: The default printer driver settings determine the settings used in all print jobs, unless settings are changed in the **Page Setup**, **Print**, or **Printer Properties** dialog boxes.

- **Printer control panel settings**: Settings changed at the printer control panel have a lower priority than changes made anywhere else.

Change the settings for all print jobs until the software program is closed

1. From the software program, select the **Print** option.
2. Select the driver, and then click **Properties** or **Preferences**.

Change the default settings for all print jobs

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view)**: Click **Start**, and then click **Printers and Faxes**.

   Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view): Click **Start**, click **Settings**, and then click **Printers**.

   **Windows Vista**: Click **Start**, click **Control Panel**, and then in the category for **Hardware and Sound** click **Printer**.

   **Windows 7**: Click **Start**, and then click **Devices and Printers**.

2. Right-click the driver icon, and then select **Printing Preferences**.
Change the product configuration settings

1. **Windows XP, Windows Server 2003, and Windows Server 2008 (using the default Start menu view):** Click Start, and then click Printers and Faxes.

   **Windows XP, Windows Server 2003, and Windows Server 2008 (using the Classic Start menu view):** Click Start, click Settings, and then click Printers.

   **Windows Vista:** Click Start, click Control Panel, and then in the category for Hardware and Sound click Printer.

   **Windows 7:** Click Start, and then click Devices and Printers.

2. Right-click the driver icon, and then select Properties or Printer properties.

3. Click the Device Settings tab.
Change print-job settings (Mac OS X)

Priority for changing print-job settings

Changes to print settings are prioritized depending on where the changes are made:

NOTE: The names of commands and dialog boxes might vary depending on your software program.

- **Page Setup dialog box**: Click Page Setup or a similar command on the File menu of the program you are working in to open this dialog box. Settings changed here might override settings changed anywhere else.

- **Print dialog box**: Click Print, Print Setup, or a similar command on the File menu of the program you are working in to open this dialog box. Settings changed in the Print dialog box have a lower priority and do not override changes made in the Page Setup dialog box.

- **Default printer driver settings**: The default printer driver settings determine the settings used in all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog boxes.

- **Printer control panel settings**: Settings changed at the printer control panel have a lower priority than changes made anywhere else.

Change the settings for all print jobs until the software program is closed

1. On the File menu, click the Print button.
2. Change the settings that you want on the various menus.

Change the default settings for all print jobs

1. On the File menu, click the Print button.
2. Change the settings that you want on the various menus.
3. On the Presets menu, click the Save As... option and type a name for the preset.

These settings are saved in the Presets menu. To use the new settings, you must select the saved preset option every time you open a program and print.

Change the product configuration settings

1. From the Apple menu , click the System Preferences menu and then click the Print & Fax icon.
2. Select the product in the left side of the window.
3. Click the Options & Supplies button.
4. Click the **Driver** tab.

5. Configure the installed options.
Print tasks for Windows

Use a printing shortcut (Windows)

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Printing Shortcuts** tab.

4. Select one of the shortcuts, and then click the **OK** button.

**NOTE:** When you select a shortcut, the corresponding settings change on the other tabs in the printer driver.

---

**Create a printing shortcut (Windows)**

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Printing Shortcuts** tab.

4. Select an existing shortcut as a base.

   **NOTE:** Always select a shortcut before adjusting any of the settings on the right side of the screen. If you adjust the settings and then select a shortcut, or if you select a different shortcut, all your adjustments are lost.
5. Select the print options for the new shortcut. 

**NOTE:** You can select the print options on this tab or on any other tab in the printer driver. After selecting options on other tabs, return to the **Printing Shortcuts** tab before continuing with the next step.

6. Click the **Save As** button.

7. Type a name for the shortcut, and click the **OK** button.
Print on both sides (duplex) with Windows

1. On the **File** menu in the software program, click **Print**.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Finishing** tab.
4. Select the **Print on both sides (manually)** check box. Click the **OK** button to print the first side of the job.

5. Retrieve the printed stack from the output bin, and maintaining the same orientation, place it with the printed-side facing down in the input tray.

6. On the control panel, press the **OK** button to print the second side of the job.

**Print multiple pages per sheet with Windows**

1. On the **File** menu in the software program, click **Print**.
2. Select the product, and then click the Properties or Preferences button.

3. Click the Finishing tab.
4. Select the number of pages per sheet from the **Pages per sheet** drop-down list.

![Page Setup Options]

5. Select the correct **Print page borders**, **Page order**, and **Orientation** options.

![Page Orientation Options]

**Select the page orientation (Windows)**

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Finishing** tab.

4. In the **Orientation** area, select the **Portrait** or **Landscape** option.

   To print the page image upside down, select the **Rotate by 180 degrees** option.
Select the paper type (Windows)

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Paper/Quality** tab.

4. From the **Paper type** drop-down list, click the **More...** option.
5. Select the category of paper types that best describes your paper.

6. Select the option for the type of paper you are using, and click the **OK** button.

---

**Print the first or last page on different paper (Windows)**

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Paper/Quality** tab.

4. Click the **Print pages on different paper** check box, and then select the necessary settings for the front cover, other pages, and back cover.
Scale a document to fit page size (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Effects tab.

4. Select the Print document on option, and then select a size from the drop-down list.
Create a booklet (Windows)

1. From the software program, select the Print option.

2. Select the product, and then click the Properties or Preferences button.

3. Click the Finishing tab.
4. Click the **Print on both sides (manually)** check box.

5. In the **Booklet layout** drop-down list, select a binding option. The **Pages per sheet** option automatically changes to **2 pages per sheet**.
Print tasks for Mac OS X

Use a printing preset (Mac OS X)

1. On the File menu, click the Print option.
2. In the Printer menu, select this product.
3. In the Presets menu, select the printing preset.

NOTE: To use printer-driver default settings, select the standard option.

Create a printing preset (Mac OS X)

Use printing presets to save the current printer driver settings for reuse.

1. On the File menu, click the Print option.
2. In the Printer menu, select this product.
3. Select the print settings that you want to save for reuse.
4. In the Presets menu, click the Save As... option, and type a name for the preset.
5. Click the OK button.

Print on both sides (Mac OS X)

1. Insert enough paper into one of the trays to accommodate the print job.
2. On the File menu, click the Print option.
3. Open the Finishing menu, and click the Manual Duplex tab or open the Manual Duplex menu.
4. Click the Manual Duplex box, and select a binding option.
5. Click the Print button. Follow the instructions in the pop-up window that appears on the computer screen before replacing the output stack in Tray 1 for printing the second half.
6. Go to the product, and remove any blank paper that is in Tray 1.
7. Insert the printed stack face-up with the bottom edge feeding into the printer first in Tray 1.
8. If prompted, press the appropriate control-panel button to continue.
Print multiple pages on one sheet of paper (Mac OS X)

1. On the File menu, click the Print option.
2. In the Printer menu, select this product.
3. Open the Layout menu.
4. From the Pages per Sheet menu, select the number of pages that you want to print on each sheet (1, 2, 4, 6, 9, or 16).
5. In the Layout Direction area, select the order and placement of the pages on the sheet.
6. From the Borders menu, select the type of border to print around each page on the sheet.

Select the page orientation (Mac OS X)

1. On the File menu, click the Print option.
2. In the Printer menu, select this product.
3. In the Copies & Pages menu, click the Page Setup button.
4. Click the icon that represents the page orientation that you want to use, and then click the OK button.

Select the paper type (Mac OS X)

1. On the File menu, click the Print option.
2. In the Printer menu, select this product.
3. Open the Finishing menu.
4. Select a type from the Media-type drop-down list.
5. Click the Print button.
Print a cover page (Mac OS X)

1. On the File menu, click the Print option.
2. In the Printer menu, select this product.
3. Open the Cover Page menu, and then select where to print the cover page. Click either the Before Document button or the After Document button.
4. In the Cover Page Type menu, select the message that you want to print on the cover page.

**NOTE:** To print a blank cover page, select the standard option from the Cover Page Type menu.

Scale a document to fit page size (Mac OS X)

1. On the File menu, click the Print option.
2. In the Printer menu, select this product.
3. Open the Paper Handling menu.
4. In the Destination Paper Size area, click the Scale to fit paper size box, and then select the size from the drop-down list.

Create a booklet (Mac OS X)

1. On the File menu, click the Print option.
2. In the Printer menu, select this product.
3. Open the Manual Duplex menu.
4. Click the Manual Duplex box.
5. Open the Booklet Printing menu.
6. Click the Format Output as Booklet box, and select a binding option.
7. Select the paper size.
Additional print tasks (Windows)

Cancel a print job (Windows)

1. If the print job is currently printing, cancel it by pressing the Cancel button on the product control panel.

   **NOTE:** Pressing the Cancel button clears the job that the product is currently processing. If more than one process is running, pressing the Cancel button clears the process that currently appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.
   - **Software program:** Typically, a dialog box appears briefly on the computer screen, allowing you to cancel the print job.
   - **Windows print queue:** If a print job is waiting in a print queue (computer memory) or print spooler, delete the job there.
     - **Windows XP, Server 2003, or Server 2008:** Click Start, click Settings, and then click Printers and Faxes. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.
     - **Windows Vista:** Click Start, click Control Panel, and then, under Hardware and Sound, click Printer. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.
     - **Windows 7:** Click Start, and then click Devices and Printers. Double-click the product icon to open the window, right-click the print job that you want to cancel, and then click Cancel.

Select the paper size (Windows)

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Select a size from the Paper size drop-down list.

Select a custom paper size (Windows)

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Click the Custom button.
5. Type a name for the custom size and specify the dimensions.
   - The width is the short edge of the paper.
   - The length is the long edge of the paper.

   **NOTE:** Always load paper into the trays short edge first.

6. Click the **Save** button, and then click the **Close** button.

**Print watermarks (Windows)**

1. From the software program, select the **Print** option.

2. Select the product, and then click the **Properties** or **Preferences** button.

3. Click the **Effects** tab.

4. Select a watermark from the **Watermarks** drop-down list.

   Or, to add a new watermark to the list, click the **Edit** button. Specify the settings for the watermark, and then click the **OK** button.

5. To print the watermark on the first page only, select the **First page only** check box. Otherwise, the watermark is printed on each page.
Additional print tasks (Mac OS X)

Cancel a print job (Mac OS X)

1. If the print job is currently printing, cancel it by pressing the Cancel × button on the product control panel.

   **NOTE:** Pressing the Cancel × button clears the job that the product is currently processing. If more than one print job is waiting, pressing the Cancel × button clears the print job that currently appears on the product control panel.

2. You can also cancel a print job from a software program or a print queue.
   
   - **Software program:** Typically, a dialog box appears briefly on the computer screen, allowing you to cancel the print job.
   
   - **Mac print queue:** Open the print queue by double-clicking the product icon in the dock. Highlight the print job, and then click **Delete**.

Select the paper size (Mac OS X)

1. On the **File** menu, click the **Print** option.

2. In the **Printer** menu, select this product.

3. In the **Copies & Pages** menu, click the **Page Setup** button.

4. Select a size from the **Paper Size** drop-down list, and then click the **OK** button.

Select a custom paper size (Mac OS X)

1. On the **File** menu, click the **Print** option.

2. In the **Printer** menu, select this product.

3. In the **Copies & Pages** menu, click the **Page Setup** button.

4. From the **Paper Size** drop-down list, select the **Manage Custom Sizes** option.

5. Specify the dimensions for the page size, and then click the **OK** button.

Print watermarks (Mac OS X)

1. On the **File** menu, click the **Print** option.

2. In the **Printer** menu, select this product.

3. Open the **Watermarks** menu.

4. From the **Mode** menu, select the type of watermark to use. Select the **Watermark** option to print a semi-transparent message. Select the **Overlay** option to print a message that is not transparent.
5. From the **Pages** menu, select whether to print the watermark on all pages or on the first page only.

6. From the **Text** menu, select one of the standard messages, or select the **Custom** option and type a new message in the box.

7. Select options for the remaining settings.
Create archival-quality prints

**NOTE:** Using this feature uses more toner.

Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print to create documents that you want to preserve or archive.

Create archival-quality prints (LCD control panel)

**NOTE:** This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - Service
   - Archive Print
3. Select the On or Off option, and then press the OK button.

Create archival-quality prints (touchscreen control panel)

**NOTE:** This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Service menu.
3. Touch the Archive Print button, and then touch the On button.
Color printing

Use the HP EasyColor option

If you are using the HP PCL 6 printer driver for Windows, the HP EasyColor technology automatically improves mixed-content documents that are printed from Microsoft Office programs. This technology scans documents and automatically adjusts photographic images in .JPEG or .PNG format. HP EasyColor technology enhances the entire image at one time, rather than dividing it into several pieces, which results in improved color consistency, sharper details, and faster printing.

If you are using the HP Postscript printer driver for Mac, HP EasyColor technology scans all documents and automatically adjusts all photographic images with the same improved photographic results.

In the following example, the images on the left were created without using the HP EasyColor option. The images on the right show the enhancements that result from using the HP EasyColor option.

The HP EasyColor option is enabled by default in both the HP PCL 6 printer driver and the HP Mac Postscript printer driver, so you do not need to make manual color adjustments. To disable the option so you can manually adjust the color settings, open the Color tab in the Windows driver or the Color/Quality Options tab in the Mac driver, and then click the HP EasyColor check box to clear it.
Change color options (Windows)

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.

3. Click the Color tab.
4. Click the Automatic or Manual setting.
   - **Automatic** setting: Select this setting for most color print jobs.
   - **Manual** setting: Select this setting to adjust the color settings independent from other settings.

   **NOTE:** Changing color settings manually can impact output. HP recommends that only color graphics experts change these settings.

5. Click the Print in Grayscale option to print a color document in black and shades of gray. Use this option to print color documents for photocopying or faxing. You can also use this option to print draft copies or to save color toner.
6. Click the OK button.

Change the color theme for a print job (Windows)

1. From the software program, select the Print option.
2. Select the product, and then click the \textbf{Properties} or \textbf{Preferences} button.

3. Click the \textbf{Color} tab.

4. Select a color theme from the \textbf{Color Themes} drop-down list.
   
   - \textbf{Default} (sRGB): This theme sets the product to print RGB data in raw device mode. When using this theme, manage color in the software program or in the operating system for correct rendering.

   - \textbf{Vivid}: The product increases the color saturation in the midtones. Use this theme when printing business graphics.

   - \textbf{Photo}: The product interprets RGB color as if it were printed as a photograph using a digital mini lab. The product renders deeper, more saturated colors differently than with the Default (sRGB) theme. Use this theme when printing photos.

   - \textbf{Photo (Adobe RGB 1998)}: Use this theme with printing digital photos that use the AdobeRGB color space rather than sRGB. Turn off color management in the software program when using this theme.

   - \textbf{None}: No color theme is used.

\textbf{Change the color options (Mac OS X)}

1. On the \textbf{File} menu, click the \textbf{Print} option.
2. In the \textbf{Printer} menu, select this product.
3. Open the \textbf{Color/Quality Options} menu.
4. Open the \textbf{Advanced} menu.
5. Adjust the individual settings for text, graphics, and photographs.
Manual color options

Use manual color options to adjust the **Neutral Grays**, **Halftone**, and **Edge Control** options for text, graphics, and photographs.

### Table 3-1 Manual color options

<table>
<thead>
<tr>
<th>Setting description</th>
<th>Setting options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edge Control</strong></td>
<td></td>
</tr>
<tr>
<td>The <strong>Edge Control</strong> setting determines the rendering of edges. Edge control has two components: adaptive halftoning and trapping. Adaptive halftoning increases edge sharpness. Trapping reduces the effect of color-plane misregistration by overlapping the edges of adjacent objects slightly.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Off</strong> turns off both trapping and adaptive halftoning.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Light</strong> sets trapping at a minimal level. Adaptive halftoning is on.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Normal</strong> sets trapping at a medium level. Adaptive halftoning is on.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Maximum</strong> is the most aggressive trapping setting. Adaptive halftoning is on.</td>
<td></td>
</tr>
<tr>
<td><strong>Halftone</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Halftone</strong> options affect color output clarity and resolution.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Smooth</strong> provides better results for large, solid-filled print areas and enhances photographs by smoothing color gradations. Select this option when uniform and smooth area fills are important.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Detail</strong> is useful for text and graphics that require sharp distinctions among lines or colors, or images that contain a pattern or a high level of detail. Select this option when sharp edges and small details are important.</td>
<td></td>
</tr>
<tr>
<td><strong>Neutral Grays</strong></td>
<td></td>
</tr>
<tr>
<td>The <strong>Neutral Grays</strong> setting determines the method for creating gray colors used in text, graphics, and photographs.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Black Only</strong> generates neutral colors (grays and black) by using only black toner. This guarantees neutral colors without a color cast. This setting is best for documents and grayscale viewgraphs.</td>
<td></td>
</tr>
<tr>
<td>- <strong>4-Color</strong> generates neutral colors (grays and black) by combining all four toner colors. This method produces smoother gradients and transitions to other colors, and it produces the darkest black.</td>
<td></td>
</tr>
</tbody>
</table>

Match colors

For most users, the best method for matching colors is to print sRGB colors.

The process of matching printer output color to your computer screen is complex, because printers and computer monitors use different methods of producing color. Monitors *display* colors by using light pixels that use an RGB (red, green, blue) color process, but printers *print* colors by using a CMYK (cyan, magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:

- Print media
- Printer colorants (inks or toners, for example)
- Printing process (inkjet, press, or laser technology, for example)
- Overhead lighting
- Personal differences in perception of color
Keep these factors in mind when colors on your screen do not perfectly match your printed colors.

**Print colored text as black (Windows)**

1. From the software program, select the **Print** option.
2. Select the product, and then click the **Properties** or **Preferences** button.
3. Click the **Paper/Quality** tab.
4. Click the **Print All Text as Black** check box. Click the **OK** button.
Use HP ePrint

Use HP ePrint to print documents by sending them as an email attachment to the product's email address from any email enabled device.

**NOTE:** The product must be connected to a wired or wireless network and have Internet access to use HP ePrint.

Use HP ePrint (LCD control panel)

**NOTE:** This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. To use HP ePrint, you must first enable HP Web Services.
   a. At the control panel, press the OK button to open the menus.
   b. Select the **HP Web Services** menu, and then press the OK button.
   c. Select the **Enable Web Services** option, and then press the OK button.
      When the Web Services option is enabled, the product prints an information sheet that includes the product code and instructions to sign up at [www.eprintcenter.com](http://www.eprintcenter.com).

2. Once you have registered the product, use the HP ePrintCenter Web site to define security settings and to configure default print settings for all HP ePrint jobs sent to this product.
   a. Go to [www.hpeprintcenter.com](http://www.hpeprintcenter.com).
   b. Click **Sign In**, and enter your HP ePrintCenter credentials or sign up for a new account.
   c. Select your product from the list, or click **+ Add printer** to add it. To add the product, you need the printer code, which is the segment of the product email address that is before the @ symbol.
      **NOTE:** This code is valid for only 24 hours from the time you enable HP Web Services. If it expires, follow the instructions to enable HP Web Services again, and obtain a new code.
   d. To prevent your product from printing unexpected documents, click **ePrint Settings**, and then click the **Allowed Senders** tab. Click **Allowed Senders Only**, and add the email addresses from which you want to allow ePrint jobs.
   e. To set up default settings for all ePrint jobs sent to this product, click **ePrint Settings**, click **Print Options**, and select the settings that you want to use.

3. To print a document, attach it to an email message sent to the product's email address.
Use HP ePrint (touchscreen control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. To use HP ePrint, you must first enable HP Web Services.
   a. From the Home screen on the product control panel, touch the Web Services button.
   b. Touch the Enable Web Services button.

   When the Web Services option is enabled, the product prints an information sheet that includes the product code and instructions to sign up at www.eprintcenter.com.

2. Once you have registered the product, use the HP ePrintCenter Web site to define security settings and to configure default print settings for all HP ePrint jobs sent to this product.
   b. Click Sign In, and enter your HP ePrintCenter credentials or sign up for a new account.
   c. Select your product from the list, or click + Add printer to add it. To add the product, you need the printer code, which is the segment of the product email address that is before the @ symbol.

   NOTE: This code is valid for only 24 hours from the time you enable HP Web Services. If it expires, follow the instructions to enable HP Web Services again, and obtain a new code.

   d. To prevent your product from printing unexpected documents, click ePrint Settings, and then click the Allowed Senders tab. Click Allowed Senders Only, and add the email addresses from which you want to allow ePrint jobs.

   e. To set up default settings for all ePrint jobs sent to this product, click ePrint Settings, click Print Options, and select the settings that you want to use.

3. To print a document, attach it to an email message sent to the product's email address.
Use AirPrint

Direct printing using Apple’s AirPrint is supported for iOS 4.2 or later. Use AirPrint to print directly to the product from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) in the following applications:

- Mail
- Photos
- Safari
- Select third-party applications

To use AirPrint, the product must be connected to a network. For more information about using AirPrint and about which HP products are compatible with AirPrint, go to [www.hp.com/go/airprint](http://www.hp.com/go/airprint).

**NOTE:** You might need to upgrade the product firmware to use AirPrint. Go to [www.hp.com/support/ljcolorm251series](http://www.hp.com/support/ljcolorm251series).
Walk-up USB printing

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

This product features printing from a USB flash drive, so you can quickly print files without sending them from a computer. The product accepts standard USB storage accessories in the USB port on the front of the product. You can print the following types of files:

- .PDF
- .JPEG

1. Insert the USB drive into the USB port on the front of the product.

2. The USB Flash Drive menu opens. Touch the arrow buttons to scroll through the options.
   - Print Documents
   - View and Print Photos
   - Scan to USB Drive

3. To print a document, touch the Print Documents screen, and then touch the name of the folder on the USB drive where the document is stored. When the summary screen opens, you can touch it to adjust the settings. Touch the Print button to print the document.

4. To print photos, touch the View and Print Photos screen, and then touch the preview image for each photo that you want to print. Touch the Done button. When the summary screen opens, you can touch it to adjust the settings. Touch the Print button to print the photos.

5. Retrieve the printed job from the output bin, and remove the USB drive.
4 Manage and maintain the product

- Use the HP Reconfiguration Utility to change the product connection
- Use HP Web Services applications
- Configure IP network settings
- HP Device Toolbox (Windows)
- HP Utility for Mac OS X
- HP Web Jetadmin
- Product security features
- Economy settings
- Print when a toner cartridge is at estimated end of life
- Store and recycle supplies
- Replacement instructions
- Update the firmware
Use the HP Reconfiguration Utility to change the product connection

If you are already using the product and you wish to change the way it is connected, use the HP Reconfiguration Utility to set up the connection. For example, you can reconfigure the product to use a different wireless address, to connect to a wired or wireless network, or change from a network connection to a USB connection. You can change the configuration without inserting the product CD. After you select the type of connection you wish to make, the program goes directly to the portion of the product setup procedure that needs to change.

The HP Reconfiguration Utility is located in the HP programs group on your computer.
Use HP Web Services applications

Several innovative applications are available for this product that you can download directly from the Internet. For more information and to download these applications go to the HP ePrintCenter Web site at www.hpeprintcenter.com.

To use this feature, the product must be connected to a computer or network that has an Internet connection. HP Web Services must be enabled on the product. Follow this procedure to enable HP Web Services:

Use HP Web Services applications (LCD control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. On the control panel, press the OK button.
2. Select the HP Web Services menu, and then press the OK button.
3. Select the Enable Web Services menu, and then press the OK button.

After you download an application from the HP ePrintCenter Web site, it is available in the Apps menu on the product control panel.

Use HP Web Services applications (touchscreen control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the product control panel, touch the Web Services button.
2. Touch the Enable Web Services button.

After you download an application from the HP ePrintCenter Web site, it is available in the Apps menu on the product control panel.
Configure IP network settings

View or change network settings

Use the **HP Device Toolbox** to view or change IP configuration settings.

1. Print a configuration page, and locate the IP address.
   - If you are using IPv4, the IP address contains only digits. It has this format:
     
     xxx.xxx.xxx.xxx
   - If you are using IPv6, the IP address is a hexadecimal combination of characters and digits. It has a format similar to this:
     
     xxxxx::xxxx::xxxx::xxxx

2. Open the **HP Device Toolbox** by clicking the **Start** button, clicking the **Programs** or **All Programs** group, clicking **HP**, clicking the product group, and then clicking **HP Product Settings**.

3. Click the **Networking** tab to obtain network information. You can change settings as needed.

Manually configure IPv4 TCP/IP parameters from the control panel

Manually configure IPv4 TCP/IP parameters (LCD control panel)

<table>
<thead>
<tr>
<th>NOTE:</th>
<th>This section applies to the HP LaserJet Pro 200 color M251n Printer model only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>On the control panel, press the <strong>OK</strong> button.</td>
</tr>
<tr>
<td>2.</td>
<td>Use the arrow buttons to select the <strong>Network Setup</strong> option, and then press the OK button.</td>
</tr>
<tr>
<td>3.</td>
<td>Use the arrow buttons to select the <strong>TCP/IP configuration</strong> option, and then press the <strong>OK</strong> button.</td>
</tr>
<tr>
<td>4.</td>
<td>Use the arrow buttons to select the <strong>Manual</strong> option, and then press the <strong>OK</strong> button.</td>
</tr>
<tr>
<td>5.</td>
<td>Use the alphanumeric buttons to type the IP address, and then press the <strong>OK</strong> button.</td>
</tr>
<tr>
<td>6.</td>
<td>If the IP address is incorrect, use the arrow buttons to select the <strong>No</strong> option, and then press the <strong>OK</strong> button. Repeat step 5 with the correct IP address, and then repeat step 5 for the subnet mask and default gateway settings.</td>
</tr>
</tbody>
</table>

Manually configure IPv4 TCP/IP parameters (touchscreen control panel)

<table>
<thead>
<tr>
<th>NOTE:</th>
<th>This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the control-panel menus to manually set an IPv4 address, subnet mask, and default gateway.</td>
<td></td>
</tr>
<tr>
<td>1.</td>
<td>From the Home screen on the product control panel, touch the <strong>Setup</strong> button.</td>
</tr>
<tr>
<td>2.</td>
<td>Scroll to and touch the <strong>Network Setup</strong> menu.</td>
</tr>
</tbody>
</table>
3. Touch the **TCP/IP Config** menu, and then touch the **Manual** button.

4. Use the numeric keypad to enter the IP address, and touch the **OK** button. Touch the **Yes** button to confirm.

5. Use the numeric keypad to enter the subnet mask, and touch the **OK** button. Touch the **Yes** button to confirm.

6. Use the numeric keypad to enter the default gateway, and touch the **OK** button. Touch the **Yes** button to confirm.

**Rename the product on a network**

If you want to rename the product on a network so that it can be uniquely identified, use the HP Embedded Web Server.

1. To open the HP Embedded Web Server, type the product IP address into the address line of a Web browser.

   ![NOTE:](image)

   You can also access the HP Embedded Web Server from the HP Device Toolbox for Windows or the HP Utility for Mac OS X.

2. Open the **System** tab.

3. On the **Device Information** page, the default product name is in the **Device Status** field. You can change this name to uniquely identify this product.

   ![NOTE:](image)

   Completing the other fields on this page is optional.

4. Click the **Apply** button to save the changes.
Link speed and duplex settings

NOTE: This information applies only to Ethernet networks. It does not apply to wireless networks.

The link speed and communication mode of the print server must match the network hub. For most situations, leave the product in automatic mode. Incorrect changes to the link speed and duplex settings might prevent the product from communicating with other network devices. If you need to make changes, use the product control panel.

NOTE: The setting must match with the network product to which you are connecting (a network hub, switch, gateway, router, or computer).

NOTE: Making changes to these settings causes the product to turn off and then on. Make changes only when the product is idle.

Link speed and duplex settings (LCD control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. On the control panel, press the OK button.
2. Use the arrow buttons to select the Network Setup option, and then press the OK button.
3. Use the arrow buttons to select the Link Speed option, and then press the OK button.
4. Use the arrow buttons to select one of the following settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The print server automatically configures itself for the highest link speed and communication mode allowed on the network.</td>
</tr>
<tr>
<td>10T Half</td>
<td>10 megabytes per second (Mbps), half-duplex operation</td>
</tr>
<tr>
<td>10T Full</td>
<td>10 Mbps, full-duplex operation</td>
</tr>
<tr>
<td>100TX Half</td>
<td>100 Mbps, half-duplex operation</td>
</tr>
<tr>
<td>100TX Full</td>
<td>100 Mbps, full-duplex operation</td>
</tr>
</tbody>
</table>

5. Press the OK button. The product turns off and then on.

Link speed and duplex settings (touchscreen control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the product control panel, touch the Setup button.
2. Scroll to and touch the Network Setup menu.
3. Touch the Link Speed menu.
4. Select one of the following options.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>The print server automatically configures itself for the highest link speed and communication mode allowed on the network.</td>
</tr>
<tr>
<td>10T Half</td>
<td>10 megabytes per second (Mbps), half-duplex operation</td>
</tr>
<tr>
<td>10T Full</td>
<td>10 Mbps, full-duplex operation</td>
</tr>
<tr>
<td>100TX Half</td>
<td>100 Mbps, half-duplex operation</td>
</tr>
<tr>
<td>100TX Full</td>
<td>100 Mbps, full-duplex operation</td>
</tr>
</tbody>
</table>

5. Touch the OK button. The product turns off and then on.
**HP Device Toolbox (Windows)**

Use the HP Device Toolbox for Windows to view or change product settings from your computer. This tool opens the HP Embedded Web Server for the product.

*NOTE:* This tool is available only if you performed a full installation when you installed the product.

1. Click the **Start** button, and then click the **Programs** item.
2. Click your HP product group, and then click the **HP Device Toolbox** item.

<table>
<thead>
<tr>
<th>Tab or section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Status</strong> tab</td>
<td>Provides product, status, and configuration information.</td>
</tr>
<tr>
<td>• <strong>Device Status</strong>: Shows the product status and shows the approximate percent life remaining of HP supplies.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Supplies Status</strong>: Shows the approximate percent life remaining of HP supplies. Actual supply life remaining can vary. Consider having a replacement supply available to install when print quality is no longer acceptable. The supply does not need to be replaced unless the print quality is no longer acceptable.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Device Configuration</strong>: Shows the information found on the product configuration page.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Network Summary</strong>: Shows the information found on the product network configuration page.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Reports</strong>: Allows you to print the configuration and supplies status pages that the product generates.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Color Usage Log</strong>: Shows a log that shows the user name, application name, and color usage information on a job-by-job basis.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Event Log</strong>: Shows a list of all product events and errors.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Support</strong> button: Provides a link to the product support page.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Shop for Supplies</strong> button: Provides a link to a page where you can order supplies for the product.</td>
<td></td>
</tr>
<tr>
<td>Tab or section</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>System tab</strong></td>
<td>Provides the ability to configure the product from your computer.</td>
</tr>
<tr>
<td><strong>Device Information</strong>: Provides basic product and company information.</td>
<td></td>
</tr>
<tr>
<td><strong>Paper Setup</strong>: Allows you to change the paper-handling defaults for the product.</td>
<td></td>
</tr>
<tr>
<td><strong>Print Quality</strong>: Allows you to change the print quality defaults for the product, including calibration settings.</td>
<td></td>
</tr>
<tr>
<td><strong>Print Density</strong>: Allows you to change the contrasts, highlights, midtones, and shadows values for each supply.</td>
<td></td>
</tr>
<tr>
<td><strong>Paper Types</strong>: Allows you to configure print modes that correspond to the paper types that the product accepts.</td>
<td></td>
</tr>
<tr>
<td><strong>System Setup</strong>: Allows you to change the system defaults for the product.</td>
<td></td>
</tr>
<tr>
<td><strong>Service</strong>: Allows you to start the cleaning procedure on the product.</td>
<td></td>
</tr>
<tr>
<td><strong>Product Security</strong>: Allows you to set or change the product password.</td>
<td></td>
</tr>
<tr>
<td><strong>Support</strong> button: Provides a link to the product support page.</td>
<td></td>
</tr>
<tr>
<td><strong>Shop for Supplies</strong> button: Provides a link to a page where you can order supplies for the product.</td>
<td></td>
</tr>
<tr>
<td><strong>NOTE</strong>: The System tab can be password-protected. If this product is on a network, always consult with the administrator before changing settings on this tab.</td>
<td></td>
</tr>
<tr>
<td><strong>Print tab</strong></td>
<td>Provides the ability to change default print settings from your computer.</td>
</tr>
<tr>
<td><strong>Printing</strong>: Change the default product print settings, such as number of copies and paper orientation. These are the same options that are available on the control panel.</td>
<td></td>
</tr>
<tr>
<td><strong>PCL5c</strong>: View and change the PCL5c settings.</td>
<td></td>
</tr>
<tr>
<td><strong>PostScript</strong>: View and change the PS settings.</td>
<td></td>
</tr>
<tr>
<td><strong>Networking tab</strong></td>
<td>Provides the ability to change network settings from your computer.</td>
</tr>
<tr>
<td><strong>Networking</strong>: Network administrators can use this tab to control network-related settings for the product when it is connected to an IP-based network. This tab does not appear if the product is directly connected to a computer.</td>
<td></td>
</tr>
<tr>
<td><strong>HP Web Services tab</strong></td>
<td>Use this tab to set up and use various Web tools with the product.</td>
</tr>
</tbody>
</table>
HP Utility for Mac OS X

Use the HP Utility for Mac OS X to view or change product settings from your computer. This tool opens the HP Embedded Web Server for the product.

You can use the HP Utility when the product is connected with a USB cable or is connected to a TCP/IP-based network.

Open the HP Utility

▲ From the dock, click **HP Utility**.

-or-

From **Applications**, click **Hewlett Packard**, and then click **HP Utility**.

HP Utility features

Use the HP Utility software to perform the following tasks:

- Obtain information about supplies status.
- Obtain information about the product, such as the firmware version and the serial number.
- Print a configuration page.
- Configure the paper type and size for the tray.
- Transfer files and fonts from the computer to the product.
- Update the product firmware.
- Display the color usage page.
HP Web Jetadmin

HP Web Jetadmin is an award-winning, industry-leading tool for efficiently managing a wide variety of networked HP devices, including printers, multifunction products, and digital senders. This single solution allows you to remotely install, monitor, maintain, troubleshoot, and secure your printing and imaging environment — ultimately increasing business productivity by helping you save time, control costs, and protect your investment.

HP Web Jetadmin updates are periodically made available to provide support for specific product features. Visit www.hp.com/go/webjetadmin and click the Self Help and Documentation link to learn more about updates.

**NOTE:** Device plug-ins can be installed into HP Web Jetadmin to provide support for specific product features.

**NOTE:** Browsers must be Java-enabled. Web Jetadmin is not supported for Mac OS X.
Product security features

The product supports security standards and recommended protocols that help you keep the product secure, protect critical information on your network, and simplify the way you monitor and maintain the product.

For in-depth information about HP’s secure imaging and printing solutions, visit www.hp.com/go/secureprinting. The site provides links to white papers and FAQ documents about security features.

Set or change the product password

Use the HP Embedded Web Server to set a password or change an existing password for a product on a network.

1. To open the HP Embedded Web Server, type the product IP address into the address line of a Web browser.

   **NOTE:** You can also access the HP Embedded Web Server from the HP Device Toolbox for Windows or the HP Utility for Mac OS X.

2. Click the Settings tab, and click the Security link.

   **NOTE:** If a password has previously been set, you are prompted to type the password. Type the password, and then click the Apply button.

3. Type the new password in the New Password box and in the Verify password box.

4. At the bottom of the window, click the Apply button to save the password.
Economy settings

Print with EconoMode

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner. However, using EconoMode can also reduce print quality.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the toner cartridge.

NOTE: This feature is available with the PCL 6 printer driver for Windows. If you are not using that driver, you can enable the feature by using the HP Embedded Web Server.

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Click the EconoMode check box.

Set the sleep delay

Set the sleep delay (LCD control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   ● System Setup
   ● Energy Settings
   ● Sleep Delay
3. Select the time for the delay, and then press the OK button.

NOTE: The default value is 15 minutes.
Set the sleep delay (touchscreen control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the product control panel, touch the Setup button.

2. Open the following menus:
   - System Setup
   - Energy Settings
   - Sleep Delay

3. Select the time for the sleep delay.

   NOTE: The default value is 15 Minutes.

Set the Auto Power Down delay

Set the Auto Power Down delay (LCD control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. At the control panel, press the OK button to open the menus.

2. Open the following menus:
   - System Setup
   - Energy Settings
   - Auto Power Down
   - Auto-Off Delay

3. Select the time for the power-down delay.

   NOTE: The default value is 30 Minutes.

4. The product automatically wakes from the auto power-down mode when it receives jobs or when you press a button on the control panel. You can change which events cause the product to wake. Open the following menus:
   - System Setup
   - Energy Settings
   - Auto Power Down
   - Wake Events

   To turn off a wake event, select the event and then select the No option.
Set the Auto Power Down delay (touchscreen control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the product control panel, touch the Setup button.

2. Open the following menus:
   - System Setup
   - Energy Settings
   - Auto Power Down
   - Auto-Off Delay

3. Select the time for the power-down delay.
   NOTE: The default value is 30 Minutes.

4. The product automatically wakes from the auto power-down mode when it receives jobs or when you press a button on the control panel. You can change which events cause the product to wake. Open the following menus:
   - System Setup
   - Energy Settings
   - Auto Power Down
   - Wake Events

   To turn off a wake event, select the event and then select the No option.
Print when a toner cartridge is at estimated end of life

Supply-related notifications are communicated on the product control panel, Desktop Alerts, software applications, and network alerts.

A <Supply> Low message—where <Supply> is the color toner cartridge: The product indicates when a supply level is low. Actual cartridge life remaining may vary. Consider having a replacement available to install when print quality is no longer acceptable. The supply does not need to be replaced now.

A <Supply> Very Low message. The product indicates when a supply level is very low. Actual cartridge life remaining may vary. Consider having a replacement available to install when print quality is no longer acceptable. The supply does not need to be replaced now unless the print quality is no longer acceptable. Once an HP supply has reached Very Low, HP's Premium Protection Warranty on that supply has ended.

Print-quality problems can occur when using a toner cartridge that is at its estimated end of life. The supply does not need to be replaced at this point in time unless the print quality is no longer acceptable.

NOTE: Using the Continue setting allows printing beyond Very Low without customer interaction and can result in unsatisfactory print quality.

Enable or disable the At Very Low settings (LCD control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

You can enable or disable the default setting at any time, and you do not have to re-enable it when you install a new toner cartridge.

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - System Setup
   - Supply Settings
   - Black Cartridge or Color Cartridges
   - Very Low Setting
3. Select one of the following options.
   - Select the Continue option to set the product to alert you that the toner cartridge is very low, but to continue printing.
   - Select the Stop option to set the product to stop printing until you replace the toner cartridge.
   - Select the Prompt option (the default option) to set the product to stop printing and prompt you to replace the toner cartridge. You can acknowledge the prompt and continue printing. The customer can choose to be prompted in 100 pages, 200 pages, 300 pages, 400 pages
or never. The default prompt setting is 100 pages. This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

- On the Color Cartridges menu only, select Print Black to alert you when the toner cartridge is very low, but to continue printing in black only.

Once an HP supply has reached Very Low, HP’s Premium Protection Warranty on that supply has ended.

Enable or disable the At Very Low settings (touchscreen control panel)

**NOTE:** This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

You can enable or disable the default settings at any time, and you do not have to re-enable them when you install a new toner cartridge.

1. From the Home screen on the control panel, touch the Setup button.
2. Open the following menus:
   - System Setup
   - Supply Settings
   - Black Cartridge or Color Cartridges
   - Very Low Setting
3. Select one of the following options:
   - Select the Continue option to set the product to alert you that the toner cartridge is very low, but to continue printing.
   - Select the Stop option to set the product to stop printing until you replace the toner cartridge.
   - Select the Prompt option (the default option) to set the product to stop printing and prompt you to replace the toner cartridge. You can acknowledge the prompt and continue printing. The customer can choose to be prompted in 100 pages, 200 pages, 300 pages, 400 pages or never. The default setting is to prompt in 100 pages. This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.
   - On the Color Cartridges menu only, select Print Black to alert you when the toner cartridge is very low, but to continue printing in black only.

Once an HP supply has reached Very Low, HP’s Premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in Continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.
Store and recycle supplies

Recycle supplies

To recycle a genuine HP toner cartridge, place the used cartridge in the box in which the new cartridge arrived. Use the enclosed return label to send the used supply to HP for recycling. For complete information, see the recycling guide that is included with each new HP supply item.

Toner cartridge storage

Do not remove the toner cartridge from its package until you are ready to use it.

⚠️ **CAUTION:** To prevent damage to the toner cartridge, do not expose it to light for more than a few minutes.
Replacement instructions

Replace the toner cartridges

1. Open the front door.

2. Pull out the toner cartridge drawer.
3. Grasp the handle on the toner cartridge, and then pull the toner cartridge straight up to remove it.

4. Remove the new toner cartridge from the packaging.

5. Gently rock the toner cartridge from front to back to distribute the toner evenly inside the cartridge.
6. Remove the plastic shield from the bottom of the new toner cartridge.

7. Do not touch the imaging drum on the bottom of the toner cartridge. Fingerprints on the imaging drum can cause print-quality problems.

8. Insert the new toner cartridge into the product.
9. Pull the tab on the left side of the toner cartridge straight up to completely remove the sealing tape. Discard the sealing tape.

10. Close the toner cartridge drawer.

11. Close the front door.

12. Place the old toner cartridge and the plastic shield in the box for the new toner cartridge. Follow the recycling instructions that are included in the box.
Update the firmware

HP offers periodic upgrades to the product firmware. You can load the firmware updates manually, or you can set the product to automatically load firmware updates.

Manually update the firmware (LCD control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - Service
   - LaserJet Update
   - Check For Updates Now
3. Select the Yes option, and then press the OK button to prompt the product to search for firmware updates. If the product detects an upgrade, it will begin the update process.

Manually update the firmware (touchscreen control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the control panel, touch the Setup button.
2. Open the following menus:
   - Service
   - LaserJet Update
   - Check For Updates Now
3. Touch the Yes button to prompt the product to search for firmware updates. If the product detects an upgrade, it will begin the update process.

Set the product to automatically update the firmware (LCD control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - Service
   - LaserJet Update
Set the product to automatically update the firmware (touchscreen control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the control panel, touch the Setup button.

2. Open the following menus:
   - Service
   - LaserJet Update
   - Manage Updates
   - Check Automatically

3. Touch the On option.
5 Solve problems

- Solve problems checklist
- Restore the factory-set defaults
- Control panel help system
- Interpret control panel messages
- Paper feeds incorrectly or becomes jammed
- Clear jams
- Improve print quality
- The product does not print or it prints slowly
- Solve walk-up USB printing problems
- Solve direct connection problems
- Solve wired network problems
- Solve wireless network problems
- Solve product software problems with Windows
- Solve product software problems with Mac OS X
- Remove software (Windows)
- Remove software (Mac OS X)
Solve problems checklist

Follow these steps when trying to solve a problem with the product.

- **Step 1: Make sure that the product is set up correctly**
- **Step 2: Check the cabling or wireless connection**
- **Step 3: Check the control panel for error messages**
- **Step 4: Check the paper**
- **Step 5: Check the software**
- **Step 6: Test print functionality**
- **Step 7: Check the supplies**
- **Step 8: Try sending a print job from a computer**

**Step 1: Make sure that the product is set up correctly**

1. Press the power button to turn on the product or to deactivate the Auto-Off mode.
2. Check the power-cable connections.
3. Make sure that the line voltage is correct for the product power configuration. (See the label that is on the back of the product for voltage requirements.) If you are using a power strip and its voltage is not within specifications, plug the product directly into the wall. If it is already plugged into the wall, try a different outlet.
4. If none of these measures restores power, contact HP Customer Care.

**Step 2: Check the cabling or wireless connection**

1. For direct USB connections or wired network connections, check the cable connection between the product and the computer. Make sure that the connection is secure.
2. Make sure that the cable itself is not faulty by using a different cable, if possible.
3. If the product is connected to a network, check the following items:
   - Check the light next to the network connection on the product. If the network is active, the light is green.
   - Make sure that you are using a network cable and not a phone cord to connect to the network.
   - Make sure the network router, hub, or switch is turned on and that it is working correctly.
   - If your computer or the product is connected to a wireless network, low signal quality or interference might be delaying print jobs.
4. If you are using a personal firewall system on the computer, it might be blocking communication with the product. Try temporarily disabling the firewall to see if it is the source of the problem.
Step 3: Check the control panel for error messages

The control panel should indicate ready status. If an error message appears, resolve the error.

Step 4: Check the paper

1. Make sure that the paper that you are using meets specifications.
2. Make sure that the paper is loaded correctly in the input tray.

Step 5: Check the software

1. Make sure that the product software is installed correctly.
2. Verify that you have installed the printer driver for this product. Check the program to make sure that you are using the printer driver for this product.

Step 6: Test print functionality

1. Print a configuration page from the product control panel.
2. If the page does not print, verify that the input tray contains paper.
3. If the page jams in the product, clear the jam.

Step 7: Check the supplies

Print a supplies status page and check remaining life of the toner cartridges.

Step 8: Try sending a print job from a computer

1. Try printing the job from another computer that has the product software installed.
2. Check the USB or network cable connection. Direct the product to the correct port, or reinstall the software, selecting the connection type that you are using.
3. If the print quality is unacceptable, verify that the print settings are correct for the media that you are using.
Restore the factory-set defaults

Restoring the factory-set defaults returns all of the product and network settings to the factory defaults. It will not reset the page count, tray size, or language. To restore the product to the factory-default settings, follow these steps.

⚠️ CAUTION: Restoring the factory-set defaults returns all of the settings to the factory defaults, and it also deletes any pages that are stored in the memory. The procedure then automatically restarts the product.

**Restore the factory-set defaults (LCD control panel)**

ือนOTE: This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - Service
   - Restore Defaults

The product automatically restarts.

**Restore the factory-set defaults (touchscreen control panel)**

ビューNOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the product control panel, touch the Setup button.
2. Scroll to and touch the Service menu.
3. Scroll to and touch the Restore Defaults button, and then touch the OK button.

The product automatically restarts.
Control panel help system

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

The product has a built-in Help system that explains how to use each screen. To open the Help system, touch the Help ? button in the upper-right corner of the screen.

For some screens, the Help opens to a global menu where you can search for specific topics. You can browse through the menu structure by touching the buttons in the menu.

Some Help screens include animations that guide you through procedures, such as clearing jams.

For screens that contain settings for individual jobs, the Help opens to a topic that explains the options for that screen.

If the product alerts you of an error or warning, touch the Help ? button to open a message that describes the problem. The message also contains instructions to help solve the problem.
Interpret control panel messages

Control panel message types

The control panel messages indicate the current product status or situations that might require action.

Alert and warning messages appear temporarily and might require you to acknowledge the message by pressing the OK button to resume or by pressing the Cancel button to cancel the job. With certain warnings, the job might not complete or the print quality might be affected. If the alert or warning message is related to printing and the auto-continue feature is on, the product will attempt to resume the printing job after the warning has appeared for 10 seconds without acknowledgement.

Critical error messages can indicate some kind of failure. Turning off and then turning on the power might fix the problem. If a critical error persists, the product might require service.

Control panel messages

10.X00Y Supply Error

Description

The memory chip for one of the toner cartridges cannot be read or is missing.

- 10.0000 = black memory chip error
- 10.0001 = cyan memory chip error
- 10.0002 = magenta memory chip error
- 10.0003 = yellow memory chip error
- 10.1000 = black memory chip is missing
- 10.1001 = cyan memory chip is missing
- 10.1002 = magenta memory chip is missing
- 10.1003 = yellow memory chip is missing

Recommended action

Reinstall the toner cartridge.

Turn the product off and then on.

If the problem is not solved, replace the toner cartridge.

49 Error Turn off then on

Description

The product experienced an internal error.
**Recommended action**

Turn the product off, wait at least 30 seconds, and then turn the product on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

### 50.x Fuser Error Turn off then on

**Description**

The product has experienced an error with the fuser.

**Recommended action**

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

Turn off the product, wait at least 25 minutes, and then turn on the product.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

### 51.XX Error Turn off then on

**Description**

The product has experienced an internal hardware error.

**Recommended action**

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product on.

If the message persists, contact HP support.

### 54.XX Error Turn off then on

**Description**

The product has experienced an error with one of the internal sensors.

**Recommended action**

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.
If the message persists, contact HP support.

**55.X Error Turn off then on**

**Description**
The product has experienced an internal error.

**Recommended action**
Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

**57 Fan error Turn off then on**

**Description**
The product has experienced a problem with its internal fan.

**Recommended action**
Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

**59.X Error Turn off then on**

**Description**
The product has experienced a problem with one of the motors.

**Recommended action**
Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

**79 Error Turn off then on**

**Description**
The product has experienced an internal firmware error.
Recommended action

Turn the product power off, wait at least 30 seconds, and then turn the product power on and wait for it to initialize.

If you are using a surge protector, remove it. Plug the product directly into the wall socket. Turn the product power on.

If the message persists, contact HP support.

Black Cartridge Low

Description
The toner cartridge is nearing the end of its useful life.

Recommended action
Printing can continue, but consider having a replacement supply on hand.

Black in wrong position

Description
The toner cartridge is installed in the incorrect slot.

Recommended action
Make sure that each toner cartridge is installed in the correct slot. From front to back, the toner cartridges are installed in this order: black, cyan, magenta, and yellow.

Black Very Low

Description
The toner cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, 400 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

Recommended action
To ensure optimal print quality, HP recommends replacing the toner cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP’s Premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.
Cleaning

Description
The product periodically performs a cleaning procedure to maintain the best print quality.

Recommended action
Wait for the cleaning process to finish.

Cyan Cartridge Low

Description
The toner cartridge is nearing the end of its useful life.

Recommended action
Printing can continue, but consider having a replacement supply on hand.

Cyan in wrong position

Description
The toner cartridge is installed in the incorrect slot.

Recommended action
Make sure that each toner cartridge is installed in the correct slot. From front to back, the toner cartridges are installed in this order: black, cyan, magenta, and yellow.

Cyan Very Low

Description
The toner cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, 400 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

Recommended action
To ensure optimal print quality, HP recommends replacing the toner cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP’s Premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.
Device error Press [OK]

Description
An internal error occurred.

Recommended action
Press the OK button to resume the job.

Door open

Description
The product toner cartridge door is open.

Recommended action
Close the door.

Genuine HP supply installed

Description
A genuine HP supply was installed.

Recommended action
No action necessary.

Incompatible <color>

Description
You have installed a toner cartridge that is intended for use in a different HP product model. The product might not function correctly with this toner cartridge installed.

Recommended action
Install the correct toner cartridge for this product.

Incorrect supplies

Description
More than one toner cartridge is installed in the incorrect slot.

Recommended action
Be sure that each toner cartridge is in the correct slot. From front to back, the toner cartridges are installed in this order: black, cyan, magenta, yellow.
Install <color> cartridge

**Description**
The toner cartridge is either not installed or not correctly installed in the product.

**Recommended action**
Install the toner cartridge.

Invalid driver Press [OK]

**Description**
You are using an incorrect printer driver.

**Recommended action**
Select the correct printer driver.

Jam in <location>

**Description**
The product has detected a jam.

**Recommended action**
Clear the jam from the location indicated. The job should continue to print. If it does not, try reprinting the job.

If the message persists, contact HP support.

Jam in Tray 1 Clear jam and then Press [OK]

**Description**
The product has detected a jam.

**Recommended action**
Clear the jam from the location indicated, and then press the OK button.

If the message persists, contact HP support.

Load tray 1 Press [OK] for available media

**Description**
The tray is empty.

**Recommended action**
Load paper into the tray to continue printing.
**Load tray 1 <TYPE>, <SIZE>**

**Description**
No trays are configured for the paper type and size that the print job is requesting.

**Recommended action**
Load the correct paper into Tray 1.

**Load tray 1 PLAIN <SIZE> Cleaning Mode**

**Description**
The product is ready to process the cleaning operation.

**Recommended action**
Load Tray 1 with plain paper in the size indicated, and then press the OK button.

**Magenta Cartridge Low**

**Description**
The toner cartridge is nearing the end of its useful life.

**Recommended action**
Printing can continue, but consider having a replacement supply on hand.

**Magenta in wrong position**

**Description**
The toner cartridge is installed in the incorrect slot.

**Recommended action**
Make sure that each toner cartridge is installed in the correct slot. From front to back, the toner cartridges are installed in this order: black, cyan, magenta, and yellow.

**Magenta Very Low**

**Description**
The toner cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, 400 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

**Recommended action**
To ensure optimal print quality, HP recommends replacing the toner cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.
Once an HP supply has reached very low, HP’s Premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.

**Manual duplex Load tray 1 Press [OK]**

**Description**
The first side of a manual duplex job has printed, and the page needs to be loaded to process the second side.

**Recommended action**
Load the page in the tray with the side to be printed face up, and the top of the page away from you, and then press the OK button.

**Memory is low Press [OK]**

**Description**
The product memory is almost full.

**Recommended action**
Press the OK button to finish the job, or press the Cancel button to cancel the job.
Break the job into smaller jobs that contain fewer pages.

**Misprint Press [OK]**

**Description**
Paper has been delayed as it moves through the product.

**Recommended action**
Press the OK button to clear the message.
To avoid this problem, try the following solutions:

1. Adjust the paper guides in the tray. Make sure the front paper guide is pushing the paper against the back edge of the tray.
2. Use paper that meets HP specifications. Store paper unopened in its original packaging.
3. Use the product in an area that meets the environmental specifications for this product.

**Print failure, press OK. If error repeats, turn off then on.**

**Description**
The product cannot process the page.
Recommended action

Press the OK button to continue printing the job, but output might be affected.

If the error persists, turn the power off and then on. Resend the print job.

Rear door open

Description

The product rear door is open.

Recommended action

Close the door.

Remove shipping lock from <color> cartridge

Description

A toner cartridge shipping lock is installed.

Recommended action

Pull the orange tab to remove the shipping lock from the cartridge.

Remove shipping locks from cartridges

Description

A toner cartridge shipping lock is installed on one or more toner cartridges.

Recommended action

Pull the orange tab to remove the shipping lock from the cartridge.

Replace <color>

Description

The toner cartridge is at the end of its useful life, and the product is customer-configured to stop printing when it reaches the very low state.

Recommended action

To ensure optimal print quality, HP recommends replacing the toner cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary. Once an HP supply has reached very low, HP’s Premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.
Supplies low

**Description**
More than one supply item is low.

**Recommended action**
Check the supply level gauges on the control panel, or print a supplies status page to determine which toner cartridges are low.

Printing will continue until a Very Low message displays. Consider having replacement supplies on hand.

Unexpected size in tray 1 Load <size> Press [OK]

**Description**
The product has detected paper in the tray that does not match the configuration for the tray.

**Recommended action**
Load the correct paper into the tray, or configure the tray for the size that you have loaded.

Unsupported <color> Press [OK] to continue

**Description**
The product has detected a toner cartridge that was not made by HP.

**Recommended action**
Press the OK button to continue printing.

If you believe you purchased an HP supply, go to [www.hp.com/go/anticounterfeit](http://www.hp.com/go/anticounterfeit). Service or repairs that are required as a result of using unsupported supplies is not covered under HP warranty.

Used <color> cartridge is installed Press [OK] to continue

**Description**
You have installed a toner cartridge that reached the default low threshold while it was installed in another product.

**Recommended action**
Press the OK button to continue.

Used <color> in use

**Description**
You are using a toner cartridge that reached the default low threshold while it was installed in a product.
Recommended action

Printing can continue, but consider having a replacement supply on hand.

Used supplies in use

Description
You are using more than one toner cartridge that reached the default low threshold while it was installed in a product.

Recommended action
Printing can continue, but consider having replacement supplies on hand.

Yellow Cartridge Low

Description
The toner cartridge is nearing the end of its useful life.

Recommended action
Printing can continue, but consider having a replacement supply on hand.

Yellow in wrong position

Description
The toner cartridge is installed in the incorrect slot.

Recommended action
Make sure that each toner cartridge is installed in the correct slot. From front to back, the toner cartridges are installed in this order: black, cyan, magenta, and yellow.

Yellow Very Low

Description
The toner cartridge is at the end of its useful life. A customer configurable option on this product is "Prompt to Remind Me in 100 pages, 200 pages, 300 pages, 400 pages, or never." This option is provided as a customer convenience and is not an indication these pages will have acceptable print quality.

Recommended action
To ensure optimal print quality, HP recommends replacing the toner cartridge at this point. You can continue printing until you notice a decrease in print quality. Actual cartridge life may vary.

Once an HP supply has reached very low, HP’s Premium Protection Warranty on that supply has ended. All print defects or cartridge failures incurred when an HP supply is used in continue at very low mode will not be considered to be defects in materials or workmanship in the supply under the HP Print Cartridge Warranty Statement.
Paper feeds incorrectly or becomes jammed

The product does not pick up paper

If the product does not pick up paper from the tray, try these solutions.

1. Open the product and remove any jammed sheets of paper.
2. Load the tray with the correct size of paper for your job.
3. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so they are touching the paper stack without bending it.
4. Check the product control panel to see if the product is waiting for you to acknowledge a prompt to feed the paper manually. Load paper, and continue.

The product picks up multiple sheets of paper

If the product picks up multiple sheets of paper from the tray, try these solutions.

1. Remove the stack of paper from the tray and flex it, rotate it 180 degrees, and flip it over. Do not fan the paper. Return the stack of paper to the tray.
2. Use only paper that meets HP specifications for this product.
3. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the stack, and then return some of the paper to the tray.
5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so they are touching the paper stack without bending it.

Prevent paper jams

To reduce the number of paper jams, try these solutions.

1. Use only paper that meets HP specifications for this product.
2. Use paper that is not wrinkled, folded, or damaged. If necessary, use paper from a different package.
3. Use paper that has not previously been printed or copied on.
4. Make sure the tray is not overfilled. If it is, remove the entire stack of paper from the tray, straighten the stack, and then return some of the paper to the tray.
5. Make sure the paper guides in the tray are adjusted correctly for the size of paper. Adjust the guides so they are touching the paper stack without bending it.
Clear jams

Jam locations

Jams can occur in these locations:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Output bin</td>
</tr>
<tr>
<td>2</td>
<td>Rear door</td>
</tr>
<tr>
<td>3</td>
<td>Input tray</td>
</tr>
</tbody>
</table>

Loose toner might remain in the product after a jam. This problem typically resolves itself after a few sheets have been printed.

Clear jams in the paper input tray

⚠️ **CAUTION:** Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams. Damage caused by sharp objects is not covered by the warranty.

When removing jammed paper, pull it straight out from the product. Pulling jammed paper out of the product at an angle can damage the product.

⚠️ **NOTE:** Depending on where the jam is located, some of the following steps might not be necessary.
1. Pull out the tray, and lift the jam access door above the tray.

2. With both hands, grasp the paper, and carefully pull it free from the product.

3. Replace the tray.

4. Press the OK button to continue printing.
Clear jams from the output bin

⚠️ **CAUTION:** Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams. Damage caused by sharp objects will not be covered by the warranty.

1. With both hands, grasp the paper, and carefully pull it free from the product.

---

Clear jams from the rear door

1. Open the rear door.

⚠️ **CAUTION:** The fuser is located above the rear door, and it is hot. Do not attempt to reach into the area above the rear door until the fuser is cool.
2. With both hands, grasp the paper, and carefully pull it free from the product.

   **NOTE:** If the sheet tears, remove all fragments before continuing. Do not use sharp objects to remove fragments.

3. Close the rear door.
Improve print quality

Check the paper type setting (Windows)

Check the paper type setting if you are having any of the following problems:

- Toner is smearing on the printed pages.
- Repeated marks occur on the printed pages.
- Printed pages are curled.
- Toner flakes off the printed pages.
- Printed pages have small unprinted areas.

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. From the Paper type drop-down list, click the More... option.
5. Expand the list of Type is: options.
6. Expand each category of paper types until you find the paper type that you are using.
7. Select the option for the type of paper you are using, and then click the OK button.

Check the paper type setting (Mac OS X)

Check the paper type setting if you are having any of the following problems:

- Toner is smearing on the printed pages.
- Repeated marks occur on the printed pages.
- Printed pages are curled.
- Toner flakes off the printed pages.
- Printed pages have small unprinted areas.

1. On the File menu, click the Print option.
2. In the Printer menu, select this product.
3. In the Copies & Pages menu, click the Page Setup button.
4. Select a size from the Paper Size drop-down list, and then click the OK button.
5. Open the Finishing menu.
6. Select a type from the **Media-type** drop-down list.

7. Click the **Print** button.

**Check toner cartridge status**

**Print the supplies status page (LCD control panel)**

<table>
<thead>
<tr>
<th>NOTE:</th>
<th>This section applies to the HP LaserJet Pro 200 color M251n Printer model only.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Information pages reside within the product memory. These pages help diagnose and solve problems with the product.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>If the product language was not correctly set during installation, you can set the language manually so the information pages print in one of the supported languages. Change the language by using the <strong>System Setup</strong> menu on the control panel or the embedded Web server.</td>
</tr>
</tbody>
</table>

1. At the control panel, press the **OK** button to open the menus.
2. Open the **Reports** menu.
3. Select the **Supplies Status** item, and then press the **OK** button to print the report.

**Print the supplies status page (touchscreen control panel)**

<table>
<thead>
<tr>
<th>NOTE:</th>
<th>This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Information pages reside within the product memory. These pages help diagnose and solve problems with the product.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>If the product language was not correctly set during installation, you can set the language manually so the information pages print in one of the supported languages. Change the language by using the <strong>System Setup</strong> menu on the control panel or the embedded Web server.</td>
</tr>
</tbody>
</table>

1. From the Home screen on the product control panel, touch the **Setup** button.
2. Touch the **Reports** button.
3. Touch the **Supplies Status** button to print the report.

**Check the supplies status**

Check the supplies status page for the following information:

- Estimated percentage of cartridge life remaining
- Approximate pages remaining
- Part numbers for HP toner cartridges
- Number of pages printed
Print a cleaning page

Print a cleaning page to remove dust and excess toner from the paper path if you are having any of the following problems:

- Specks of toner are on the printed pages.
- Toner is smearing on the printed pages.
- Repeated marks occur on the printed pages.

Print a cleaning page (LCD control panel)

**NOTE:** This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. At the control panel, press the OK button to open the menus.
2. Open the following menus:
   - **Service**
   - **Cleaning Page**
3. Load plain paper in Tray 1, and then press the OK button to start the cleaning process.
4. The product prints the first side and then prompts you to remove the page from the output bin and reload it in Tray 1, keeping the same orientation (the side with the black stripe should be face-down with the arrow toward the back of the product).
5. Press the OK button to continue the cleaning process. Wait until the process is complete. Discard the page that prints.

Print a cleaning page (touchscreen control panel)

**NOTE:** This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the **Service** menu.
3. Touch the **Cleaning Page** button.
4. Load plain letter or A4 paper when you are prompted.
5. Touch the OK button to begin the cleaning process.
6. The product prints the first side and then prompts you to remove the page from the output bin and reload it in Tray 1, keeping the same orientation (the side with the black stripe should be face-down with the arrow toward the back of the product).
7. Press the OK button to continue the cleaning process. Wait until the process is complete. Discard the page that prints.
Perform additional print quality troubleshooting

Print the print quality page (LCD control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251n Printer model only.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Reports button.
3. Touch the Print Quality Page button.

Print the print quality page (touchscreen control panel)

NOTE: This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

1. From the Home screen on the product control panel, touch the Setup button.
2. Touch the Reports button.
3. Touch the Print Quality Page button.

Interpret the print quality page

This page contains five bands of color, which are divided into four groups as indicated in the following illustration. By examining each group, you can isolate the problem to a particular toner cartridge.

![Print quality page illustration]

<table>
<thead>
<tr>
<th>Section</th>
<th>Print-cartridge</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Yellow</td>
</tr>
<tr>
<td>2</td>
<td>Cyan</td>
</tr>
<tr>
<td>Section</td>
<td>Print-cartridge</td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
</tr>
<tr>
<td>3</td>
<td>Black</td>
</tr>
<tr>
<td>4</td>
<td>Magenta</td>
</tr>
</tbody>
</table>

- If dots or streaks appear in only one of the groups, replace the toner cartridge that correlates with that group.
- If dots appear in more than one group, print a cleaning page. If this does not solve the problem, determine if the dots are always the same color; for example, if magenta dots appear in all five color bands. If the dots are all the same color, replace that toner cartridge.
- If a streak continues through multiple color bands, contact HP. A component other than the toner cartridge is probably causing the problem.

**Inspect the toner cartridge for damage**

1. Remove the toner cartridge from the product, and verify that the sealing tape has been removed.
2. Check the memory chip for damage.
3. Examine the surface of the imaging drum on the bottom of the toner cartridge.
   
   **CAUTION:** Do not touch the roller (imaging drum) on the bottom of the cartridge. Fingerprints on the imaging drum can cause print-quality problems.

4. If you see any scratches, fingerprints, or other damage on the imaging drum, replace the toner cartridge.
5. If the imaging drum does not appear to be damaged, rock the toner cartridge gently several times and reinstall it. Print a few pages to see if the problem has resolved.
Check the paper and printing environment

Use paper that meets HP specifications

Use different paper if you are having any of the following problems:

- The printing is too light or seems faded in areas.
- Specks of toner are on the printed pages.
- Toner is smearing on the printed pages.
- Printed characters seem misformed.
- Printed pages are curled.

Always use a paper type and weight that this product supports. In addition, follow these guidelines when selecting paper:

- Use paper that is of good quality and free of cuts, nicks, tears, spots, loose particles, dust, wrinkles, voids, staples, and curled or bent edges.
- Use paper that has not been previously printed on.
- Use paper that is designed for use in laser printers. Do not use paper that is designed only for use in Inkjet printers.
- Use paper that is not too rough. Using smoother paper generally results in better print quality.

Check the product environment

Verify that the product is operating within the environmental specifications listed in the product Warranty and Legal Guide.

Check print job settings

Check the EconoMode setting

This product has an EconoMode option for printing drafts of documents. Using EconoMode can use less toner. However, using EconoMode can also reduce print quality. To improve print quality, verify that the EconoMode setting is deactivated.

1. From the software program, select the Print option.
2. Select the product, and then click the Properties or Preferences button.
3. Click the Paper/Quality tab.
4. Verify that the EconoMode check box is cleared. If there is a checkmark in the check box, click the check box to clear it.

HP does not recommend the full-time use of EconoMode. If EconoMode is used full-time, the toner supply might outlast the mechanical parts in the toner cartridge. If print quality begins to degrade and is no longer acceptable, consider replacing the toner cartridge.
Adjust color settings in the printer driver

Change the color theme for a print job

1. On the File menu in the software program, click Print.
2. Click Properties or Preferences.
3. Click the Color tab.
4. Select a color theme from the Color Themes drop-down list.

- **Default (sRGB)**: This theme sets the product to print RGB data in raw device mode. When using this theme, manage color in the software program or in the operating system for correct rendering.

- **Vivid**: The product increases the color saturation in the midtones. Use this theme when printing business graphics.

- **Photo**: The product interprets RGB color as if it were printed as a photograph using a digital mini lab. The product renders deeper, more saturated colors differently than with the Default (sRGB) theme. Use this theme when printing photos.

- **Photo (Adobe RGB 1998)**: Use this theme with printing digital photos that use the AdobeRGB color space rather than sRGB. Turn off color management in the software program when using this theme.

- **None**

Change the color options

Change the color options settings for the current print job from the color tab of the printer driver.

1. On the File menu in the software program, click Print.
2. Click Properties or Preferences.
3. Click the Color tab.
4. Click the **Automatic** or **Manual** setting.
   - **Automatic** setting: Select this setting for most color print jobs
   - **Manual** setting: Select this setting to adjust the color settings independent from other settings.

   **NOTE:** Changing color settings manually can impact output. HP recommends that only color graphics experts change these settings.

5. Click the **Print in Grayscale** option to print a color document in black and white. Use this option to print color documents for photocopying or faxing.

6. Click the **OK** button.

### Use the printer driver that best meets your printing needs

You might need to use a different printer driver if the printed page has unexpected lines in graphics, missing text, missing graphics, incorrect formatting, or substituted fonts.

<table>
<thead>
<tr>
<th>HP PCL 6 driver</th>
<th>Provided as the default driver. This driver is automatically installed unless you select a different one.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Recommended for all Windows environments</td>
</tr>
<tr>
<td></td>
<td>Provides the overall best speed, print quality, and product-feature support for most users</td>
</tr>
<tr>
<td></td>
<td>Developed to align with the Windows Graphic Device Interface (GDI) for the best speed in Windows environments</td>
</tr>
<tr>
<td></td>
<td>Might not be fully compatible with third-party and custom software programs that are based on PCL 5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP UPD PS driver</th>
<th>Recommended for printing with Adobe® software programs or with other highly graphics-intensive software programs</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Provides support for printing from postscript emulation needs, or for postscript flash font support</td>
</tr>
</tbody>
</table>
**HP UPD PCL 5**
- Recommended for general office printing in Windows environments
- Compatible with previous PCL versions and older HP LaserJet products
- The best choice for printing from third-party or custom software programs
- The best choice when operating with mixed environments, which require the product to be set to PCL 5 (UNIX, Linux, mainframe)
- Designed for use in corporate Windows environments to provide a single driver for use with multiple printer models
- Preferred when printing to multiple printer models from a mobile Windows computer

**HP UPD PCL 6**
- Recommended for printing in all Windows environments
- Provides the overall best speed, print quality, and printer feature support for most users
- Developed to align with Windows Graphic Device Interface (GDI) for best speed in Windows environments
- May not be fully compatible with third-party and custom solutions based on PCL5

Download additional printer drivers from this Web site: [www.hp.com/support/ljcolorM251series](http://www.hp.com/support/ljcolorM251series).
The product does not print or it prints slowly

The product does not print

If the product does not print at all, try the following solutions.

1. Make sure the product is turned on and that the control panel indicates it is ready.
   ◦ If the control panel does not indicate the product is ready, turn the product off and then on again.
   ◦ If the control panel indicates the product is ready, try sending the job again.

2. If the control panel indicates the product has an error, resolve the error and then try sending the job again.

3. Make sure the cables are all connected correctly. If the product is connected to a network, check the following items:
   ◦ Check the light next to the network connection on the product. If the network is active, the light is green.
   ◦ Make sure that you are using a network cable and not a phone cord to connect to the network.
   ◦ Make sure the network router, hub, or switch is turned on and that it is working correctly.

4. Install the HP software from the CD that came with the product. Using generic printer drivers can cause delays clearing jobs from the print queue.

5. From the list of printers on your computer, right-click the name of this product, click Properties, and open the Ports tab.
   ◦ If you are using a network cable to connect to the network, make sure the printer name listed on the Ports tab matches the product name on the product configuration page.
   ◦ If you are using a USB cable and are connecting to a wireless network, make sure the box is checked next to Virtual printer port for USB.

6. If you are using a personal firewall system on the computer, it might be blocking communication with the product. Try temporarily disabling the firewall to see if it is the source of the problem.

7. If your computer or the product is connected to a wireless network, low signal quality or interference might be delaying print jobs.
The product prints slowly

If the product prints, but it seems slow, try the following solutions.

1. Make sure the computer meets the minimum specifications for this product. For a list of specifications, go to this Web site: www.hp.com/support/ljcolorm251series.

2. When you configure the product to print on some paper types, such as heavy paper, the product prints more slowly so it can correctly fuse the toner to the paper. If the paper type setting is not correct for the type of paper you are using, change the setting to the correct paper type.

3. If your computer or the product is connected to a wireless network, low signal quality or interference might be delaying print jobs.
Solve walk-up USB printing problems

- The USB Flash Drive menu does not open when you insert the USB accessory
- The file does not print from the USB storage accessory
- The file that you want to print is not listed in the USB Flash Drive menu

The USB Flash Drive menu does not open when you insert the USB accessory

1. You might be using a USB storage accessory or a file system that this product does not support. Save the files on a standard USB storage accessory that uses File Allocation Table (FAT) file systems. The product supports FAT12, FAT16, and FAT32 USB storage accessories.

2. If another menu is already open, close that menu and then reinsert the USB storage accessory.

3. The USB storage accessory might have multiple partitions. (Some USB storage accessory manufacturers install software on the accessory that creates partitions, similar to a CD.) Reformat the USB storage accessory to remove the partitions, or use a different USB storage accessory.

4. The USB storage accessory might require more power than the product can provide.
   a. Remove the USB storage accessory.
   b. Turn the product off and then on.
   c. Use a USB storage accessory that has its own power supply or that requires less power.

5. The USB storage accessory might not be functioning correctly.
   a. Remove the USB storage accessory.
   b. Turn the product off and then on.
   c. Try printing from another USB storage accessory.

The file does not print from the USB storage accessory

1. Make sure paper is in the tray.

2. Check the control panel for messages. If paper is jammed in the product, clear the jam.
The file that you want to print is not listed in the USB Flash Drive menu

1. You might be trying to print a file type that the USB printing feature does not support. The product supports .PDF and .JPEG file types.

2. You might have too many files in a single folder on the USB storage accessory. Reduce the number of files in the folder by moving them to subfolders.

3. You might be using a character set for the file name that the product does not support. In this case, the product replaces the file names with characters from a different character set. Rename the files using ASCII characters.
Solve direct connection problems

If you have connected the product directly to a computer, check the cable.

- Verify that the cable is connected to the computer and to the product.
- Verify that the cable is not longer than 5 m (16.4 ft). Try using a shorter cable.
- Verify that the cable is working correctly by connecting it to another product. Replace the cable if necessary.
Solve wired network problems

Check the following items to verify that the product is communicating with the network. Before beginning, print a configuration page from the product control panel and locate the product IP address that is listed on this page.

- Poor physical connection
- The computer is using the incorrect IP address for the product
- The computer is unable to communicate with the product
- The product is using incorrect link and duplex settings for the network
- New software programs might be causing compatibility problems
- The computer or workstation might be set up incorrectly
- The product is disabled, or other network settings are incorrect

**NOTE:** HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems and not of the HP printer drivers. Go to Microsoft at [www.microsoft.com](http://www.microsoft.com).

**Poor physical connection**

1. Verify that the product is attached to the correct network port using a cable of the correct length.
2. Verify that cable connections are secure.
3. Look at the network port connection on the back of the product, and verify that the amber activity light and the green link-status light are lit.
4. If the problem continues, try a different cable or port on the hub.

**The computer is using the incorrect IP address for the product**

1. Open the printer properties and click the **Ports** tab. Verify that the current IP address for the product is selected. The product IP address is listed on the product configuration page.
2. If you installed the product using the HP standard TCP/IP port, select the box labeled **Always print to this printer, even if its IP address changes.**
3. If you installed the product using a Microsoft standard TCP/IP port, use the hostname instead of the IP address.
4. If the IP address is correct, delete the product and then add it again.
The computer is unable to communicate with the product

1. Test network communication by pinging the network.
   a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and then type cmd.
   b. Type ping followed by the IP address for your product.
      For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in the Ping pane.
   c. If the window displays round-trip times, the network is working.

2. If the ping command failed, verify that the network hubs are on, and then verify that the network settings, the product, and the computer are all configured for the same network.

The product is using incorrect link and duplex settings for the network

Hewlett-Packard recommends leaving this setting in automatic mode (the default setting). If you change these settings, you must also change them for your network.

New software programs might be causing compatibility problems

Verify that any new software programs are correctly installed and that they use the correct printer driver.

The computer or workstation might be set up incorrectly

1. Check the network drivers, printer drivers, and the network redirection.
2. Verify that the operating system is configured correctly.

The product is disabled, or other network settings are incorrect

1. Review the configuration page to check the status of the network protocol. Enable it if necessary.
2. Reconfigure the network settings if necessary.
Solve wireless network problems

**NOTE:** This section applies to the HP LaserJet Pro 200 color M251nw Printer model only.

**Wireless connectivity checklist**

- Verify that the network cable is not connected.
- Verify that the product and the wireless router are turned on and have power. Also make sure that the wireless radio in the product is turned on.
- Verify that the service set identifier (SSID) is correct. Print a configuration page to determine the SSID. If you are not sure the SSID is correct, run the wireless setup again.
- With secured networks, verify that the security information is correct. If the security information is incorrect, run the wireless setup again.
- If the wireless network is working correctly, try accessing other computers on the wireless network. If the network has Internet access, try connecting to the Internet over a wireless connection.
- Verify that the encryption method (AES or TKIP) is the same for the product as it is for the wireless access point (on networks using WPA security).
- Verify that the product is within the range of the wireless network. For most networks, the product must be within 30 m (100 ft) of the wireless access point (wireless router).
- Verify that obstacles do not block the wireless signal. Remove any large metal objects between the access point and the product. Make sure poles, walls, or support columns containing metal or concrete do not separate the product and wireless access point.
- Verify that the product is located away from electronic devices that might interfere with the wireless signal. Many devices can interfere with the wireless signal including motors, cordless phones, security system cameras, other wireless networks, and some Bluetooth devices.
- Verify that the printer driver is installed on the computer.
- Verify that you have selected the correct printer port.
- Verify that the computer and product connect to the same wireless network.

**The product does not print after the wireless configuration completes**

1. Make sure that the product is turned on and in the ready state.
2. Turn off any third-party firewalls on your computer.
3. Make sure that the wireless network is working correctly.
4. Make sure that your computer is working correctly. If necessary, restart the computer.
The product does not print, and the computer has a third-party firewall installed

1. Update the firewall with the most recent update available from the manufacturer.
2. If programs request firewall access when you install the product or try to print, make sure you allow the programs to run.
3. Temporarily turn off the firewall, and then install the wireless product on the computer. Enable the firewall when you have completed the wireless installation.

The wireless connection does not work after moving the wireless router or product

Make sure that the router or product connects to the same network that your computer connects to.

1. Print a configuration page.
2. Compare the service set identifier (SSID) on the configuration page to the SSID in the printer configuration for the computer.
3. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure the wireless setup for the product.

Cannot connect more computers to the wireless product

1. Make sure that the other computers are within the wireless range and that no obstacles block the signal. For most networks, the wireless range is within 30 m (100 ft) of the wireless access point.
2. Make sure that the product is turned on and in the ready state.
3. Turn off any third-party firewalls on your computer.
4. Make sure that the wireless network is working correctly.
5. Make sure that your computer is working correctly. If necessary, restart the computer.

The wireless product loses communication when connected to a VPN

• Typically, you cannot connect to a VPN and other networks at the same time.

The network does not appear in the wireless networks list

• Make sure the wireless router is turned on and has power.
• The network might be hidden. However, you can still connect to a hidden network.
The wireless network is not functioning

1. Make sure that the network cable is not connected.

2. To verify if the network has lost communication, try connecting other devices to the network.

3. Test network communication by pinging the network.
   a. Open a command-line prompt on your computer. For Windows, click Start, click Run, and then type cmd.
   b. Type ping followed by the router IP address.
      For Mac OS X, open the Network Utility, and then supply the IP address in the correct field in the Ping pane.
   c. If the window displays round-trip times, the network is working.

4. Make sure that the router or product connects to the same network that the computer connects to.
   a. Print a configuration page.
   b. Compare the service set identifier (SSID) on the configuration report to the SSID in the printer configuration for the computer.
   c. If the numbers are not the same, the devices are not connecting to the same network. Reconfigure the wireless setup for the product.

Perform a wireless network diagnostic test

From the product control panel, you can run a diagnostic test that provides information about the wireless network settings.

1. From the Home screen, touch the Setup button.

2. Open the following menus
   - System Setup
   - Service

3. Touch the Run Network Test button to start the test. The product prints a test page that shows test results.
Reduce interference on a wireless network

The following tips can reduce interference in a wireless network:

- Keep the wireless devices away from large metal objects, such as filing cabinets, and other electromagnetic devices, such as microwaves and cordless telephones. These objects can disrupt radio signals.
- Keep the wireless devices away from large masonry structures and other building structures. These objects can absorb radio waves and lower signal strength.
- Position the wireless router in a central location in line of sight with the wireless products on the network.
Solve product software problems with Windows

A printer driver for the product is not visible in the Printer folder

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the system tray, right-click the icon, and select Close or Disable.

2. Try plugging the USB cable into a different USB port on the computer.

An error message was displayed during the software installation

1. Reinstall the product software.

NOTE: Close any applications that are running. To close an application that has an icon in the system tray, right-click the icon, and select Close or Disable.

2. Check the amount of free space on the drive where you are installing the product software. If necessary, free up as much space as you can, and reinstall the product software.

3. If necessary, run the Disk Defragmenter, and reinstall the product software.

The product is in Ready mode, but nothing prints

1. Print a configuration page, and verify the product functionality.

2. Verify that all of the cables are correctly seated and within specifications. This includes the USB and power cables. Try a new cable.

3. Verify the IP address on the configuration page matches the IP address for the software port. Use one of the following procedures:


   a. Click Start.

   b. Click Settings.

   c. Click Printers and Faxes (using the default Start menu view) or click Printers (using the Classic Start menu view).

   d. Right-click the product driver icon, and then select Properties.

   e. Click the Ports tab, and then click Configure Port.

   f. Verify the IP address, and then click OK or Cancel.

   g. If the IP addresses are not the same, delete the driver, and reinstall the driver using the correct IP address.
Windows 7

a. Click **Start**.

b. Click **Devices and Printers**.

c. Right-click the product driver icon, and then select **Printer properties**.

d. Click the **Ports** tab, and then click **Configure Port**.

e. Verify the IP address, and then click **OK** or **Cancel**.

f. If the IP addresses are not the same, delete the driver, and reinstall the driver using the correct IP address.
Solve product software problems with Mac OS X

- The printer driver is not listed in the Print & Fax list
- The product name does not appear in the product list in the Print & Fax list
- The printer driver does not automatically set up the selected product in the Print & Fax list
- A print job was not sent to the product that you wanted
- When connected with a USB cable, the product does not appear in the Print & Fax list after the driver is selected.
- You are using a generic printer driver when using a USB connection

The printer driver is not listed in the Print & Fax list

1. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/Contents/Resources. If necessary, reinstall the software.
2. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the software.

The product name does not appear in the product list in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.
2. Print a configuration page to check the product name. Verify that the name on the configuration page matches the product name in the Print & Fax list.
3. Replace the USB or network cable with a high-quality cable.

The printer driver does not automatically set up the selected product in the Print & Fax list

1. Make sure that the cables are connected correctly and the product is on.
2. Make sure that the product .GZ file is in the following hard-drive folder: Library/Printers/PPDs/Contents/Resources. If necessary, reinstall the software.
3. If the GZ file is in the folder, the PPD file might be corrupt. Delete the file and then reinstall the software.
4. Replace the USB or network cable with a high-quality cable.
A print job was not sent to the product that you wanted

1. Open the print queue and restart the print job.
2. Another product with the same or similar name might have received your print job. Print a configuration page to check the product name. Verify that the name on the configuration page matches the product name in the Print & Fax list.

When connected with a USB cable, the product does not appear in the Print & Fax list after the driver is selected.

Software troubleshooting

▲ Make sure that your Mac operating system is Mac OS X 10.5 or later.

Hardware troubleshooting

1. Make sure that the product is turned on.
2. Make sure that the USB cable is connected correctly.
3. Make sure that you are using the appropriate high-speed USB cable.
4. Make sure that you do not have too many USB devices drawing power from the chain. Disconnect all of the devices from the chain, and then connect the cable directly to the USB port on the computer.
5. Check to see if more than two non-powered USB hubs are connected in a row on the chain. Disconnect all of the devices from the chain, and then connect the cable directly to the USB port on the computer.

NOTE: The iMac keyboard is a non-powered USB hub.

You are using a generic printer driver when using a USB connection

If you connected the USB cable before you installed the software, you might be using a generic printer driver instead of the driver for this product.

1. Delete the generic printer driver.
2. Reinstall the software from the product CD. Do not connect the USB cable until the software installation program prompts you.
3. If multiple printers are installed, make sure that you have selected the correct printer in the Format For drop-down menu in the Print dialog box.
Remove software (Windows)

Windows XP

1. Click Start, and then click Programs.
2. Click HP, and then click the product name.
3. Click Uninstall, and then follow the onscreen instructions to remove the software.

Windows Vista and Windows 7

1. Click Start, and then click All Programs.
2. Click HP, and then click the product name.
3. Click Uninstall, and then follow the onscreen instructions to remove the software.
Remove software (Mac OS X)

You must have administrator rights to remove the software.

1. Disconnect the product from the computer.
2. Open Applications.
4. Select HP Uninstaller.
5. Select the product from the list of devices, and then click the Uninstall button.
6. After the software is uninstalled, restart the computer and empty the Trash.
6 Supplies and accessories

- Order parts, accessories, and supplies
- HP policy on non-HP supplies
- HP anticounterfeit Web site
Order parts, accessories, and supplies

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
<th>Cartridge number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP LaserJet toner cartridge</td>
<td>CF210A</td>
<td>131A</td>
<td>Black toner cartridge with HP ColorSphere toner</td>
</tr>
<tr>
<td></td>
<td>CF210X</td>
<td>131X</td>
<td>Cyan toner cartridge with HP ColorSphere toner</td>
</tr>
<tr>
<td></td>
<td>CF211A</td>
<td>131A</td>
<td>Yellow toner cartridge with HP ColorSphere toner</td>
</tr>
<tr>
<td></td>
<td>CF212A</td>
<td>131A</td>
<td>Magenta toner cartridge with HP ColorSphere toner</td>
</tr>
<tr>
<td>USB 2.0 printer cable</td>
<td>C6518A</td>
<td></td>
<td>(2-meter standard) A-to-B cable</td>
</tr>
</tbody>
</table>

HP policy on non-HP supplies

Hewlett-Packard Company cannot recommend the use of non-HP toner cartridges, either new or remanufactured.

**NOTE:** For HP printer products, the use of a non-HP toner cartridge or a refilled toner cartridge does not affect either the warranty to the customer or any HP support contract with the customer. However, if product failure or damage is attributable to the use of a non-HP toner cartridge or refilled toner cartridge, HP will charge its standard time and materials charges to service the product for the particular failure or damage.

HP anticounterfeit Web site

Go to [www.hp.com/go/anticounterfeit](http://www.hp.com/go/anticounterfeit) when you install an HP toner cartridge and the control-panel message says the cartridge is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.

Your toner cartridge might not be a genuine HP toner cartridge if you notice the following:

- The supplies status page indicates that a non-HP supply is installed.
- You are experiencing a high number of problems with the toner cartridge.
- The cartridge does not look like it usually does (for example, the packaging differs from HP packaging).
Index

A
accessories  ordering 127, 128
AirPrint 53
anticounterfeit supplies 128
applications
  downloading 57
Apps menu 57
archival-quality printing 45

B
bin, output
  locating 2
bins, output
  jams, clearing 99
booklets
  printing (Mac) 40
  printing (Windows) 36

C
canceling
  print job (Mac) 43
  print job (Windows) 41
cartridges
  non-HP 128
  part numbers 128
  recycling 72
  replacing 73
  storage 72
  supplies status page 8
cleaning
  paper path 103
color
  Edge Control 49
  halftone options 49
  matching 49
  Neutral Grays 49
  printed vs. monitor 49
color options
  changing manually 49
  HP EasyColor 46
  setting (Mac) 48
  setting (Windows) 47
color settings
  adjusting 107
color theme
  changing (Windows) 47
color usage log 8
configuration page 8
counterfeit supplies 128
default gateway, setting 58
defaults, restoring 82
double-sided printing (duplexing)
  Mac 38
  drivers
    changing settings (Mac) 21
    changing settings (Windows) 19
    presets (Mac) 38
    settings (Mac) 38
    usage page 8
duplex printing (double-sided)
  settings (Windows) 27
duplex settings, changing 60
EconoMode setting 67
economy settings 67
Edge Control 49
Embedded Web Server
  changing network settings 58
  changing password 66
  changing product name 59
  opening 58, 59, 66
error messages, control panel 84
ersets
  software 121
factory-set defaults, restoring 82
fonts
  lists, printing 8
fraud Web site 128
front door, locating 2
gateway, setting default 58
grayscale printing, Windows 50
help, control panel 83
Home screen, control panel 7
HP Device Toolbox, using 62
HP Easy Color
  disabling 46
  using 46
HP Embedded Web Server
  changing network settings 58
  changing password 66
  changing product name 59
  opening 58, 59, 66
HP ePrint, using 51
HP fraud Web site 128
printing
  from USB storage accessories 54
product reports 8, 9
settings (Mac) 38
printing on both sides
  settings (Windows) 27
problem-solving
  no response 110
  slow response 111
PS font list 8
R
rear door
  jams 99
  locating 3
recycling supplies 72
replacing toner cartridges 73
reports
  Color Usage Log 8
  Config Report 8
  Demo Page 8
  Diagnostics Page 8
  Menu Structure 8
  Network Summary 8
  PCL Font List 8
  PCL6 Font List 8
  Print Quality Page 8
  PS Font List 8
  Service Page 8
  Supplies Status 8
  Usage Page 8
Reports menu 8, 9
resize documents
  Mac 40
  Windows 35
restoring factory-set defaults 82
S
scale documents
  Mac 40
  Windows 35
serial number, locating 3
service page 8
settings
  driver presets (Mac) 38
  drivers 19
  drivers (Mac) 21
factory-set defaults, restoring
  82
network report 8
shortcuts (Windows)
  creating 24
  using 23
sleep delay
  disabling 67
  enabling 67
software
  HP Utility for Mac 64
  HP Web Jetadmin 65
  problems 121
  uninstalling for Mac 126
  uninstalling for Windows 125
solving
  walk-up USB printing
    problems 112
  special paper for covers
    printing (Mac) 40
    printing (Windows) 33
status
  Home screen, control panel 7
  HP Utility, Mac 64
  supplies, printing report 8
storing
  toner cartridges 72
substrnet mask 58
supplies
  counterfeit 128
  non-HP 128
  ordering 127, 128
  part numbers 128
  recycling 72
  status, viewing with HP Utility
  for Mac 64
  supplies status page 8
  supported paper 12
T
TCP/IP
  manually configuring IPv4
    parameters 58
toner cartridges
  checking for damage 105
  door, locating 2
  non-HP 128
  part numbers 128
  recycling 72
  replacing 73
storage 72
  supplies status page 8
trapping 49
Tray 1
double-sided printing 38
trays
double-sided printing 38
  jams, clearing 97
  supported paper types 14
troubleshooting
  checklist 80
  control panel messages 84
  jams 96
  Mac problems 123
  network problems 115
  paper feed problems 96
  USB connection 114
  walk-up USB printing
    problems 112
  Windows problems 121
  wired network 115
  wireless network 117
two-sided printing
  settings (Windows) 27
U
uninstalling Mac software 126
uninstalling Windows software 125
usage page 8
USB cable, part number 128
USB connection
  troubleshooting 114
USB port
  locating 3
USB storage accessories
  printing from 54
W
walk-up USB printing 54
watermarks
  printing (Mac) 43
  printing (Windows) 42
Web Services
  applications 57
  enabling 57
Web sites
  fraud reports 128
  ordering supplies 127
Windows
  driver settings  19
wireless network
  troubleshooting  117
wireless network interference  120